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EasyManager™ Features

EasyManager™ assists you to easily manage personal information including internet 
addresses, and export/import the relevant information between other software programs. 
Some of the salient features of EasyManager are as follows:

· Manages information on people including family relationships, postal addresses, 
unlimited telephone/fax numbers, unlimited electronic mail and url/web 
addresses, date of birth, anniversaries and more. You also get reminders of 
birthdays and marriage anniversaries in the ToDo list [ referred as Person Object
].

· Lets you share home addresses and home telephone and fax numbers. You 
enter or update the home addresses or telephone numbers only once and 
EasyManager manages the consistency. See Living With and Working With 
attributes of Person Object for more information.

· Manages information on businesses including address, unlimited telephone/fax 
numbers, unlimited electronic mail and url/web addresses, and more [referred 
as Business Object].

· Manages information on all your accounts (subscriptions, credit cards, bank 
cards, etc.) including address, unlimited telephone/fax numbers, account 
numbers, access code, unlimited electronic mail and url/web addresses, and 
more [referred as Account Object].

· Manages ToDo lists. You can give any priority to ToDo objects, and also 
categorize them in any number of categories (groups) you want to [referred as 
ToDo Object].

· Manages Reminders. You can enter things that you want to be reminded of 
regularly, or only once. You can decide how many days early you want to be 
reminded. When it is time to remind, it appears in the ToDo list [referred as 
Reminder Object].

· Lets you group Person, Business, Account and ToDo objects. You can make 
groups that contain other groups. A object can be part of many different groups 
[referred as Group Object].

· EasyList™ lets you view and edit objects as lists. You can create your own lists 
or modify existing lists so you can view and edit only the attributes of the 
objects that you want to. You can filter and sort the lists anyway you want to.

· EasyEditor™ lets you view and edit all the attributes of one object at a time. 
This is the ultimate place to view and edit all the attributes of any Object.

· EasyLabel™ lets you create your own custom labels, view the label data, and 
print them on any size paper. You can also generate custom address books by 
simply printing the labels on plain sheet of paper. You can filter (EasyFilter) and 
sort (EasySort) the labels anyway you want to.

· EasyFill™ lets you enter information by completing the partially entered 
information depending on the context.

· EasyLook™ lets you quickly find objects and lookup information on any object 
without having to search for it in EasyLists or in the EasyEditor.

· EasyFilter™ lets you filter Objects in almost anyway way you want to in any 
EasyList and EasyLabel.



· EasySort™ lets you sort Objects using unlimited number of keys (primary and 
secondary keys). You can use any and all attributes as keys to sort on. The keys 
dont have to be displayed to sort.

· EasyExport™ lets you export data to ASCII files and to programs like on-line 
services including CompuServe, Spreadsheets, etc. If you have a favorite 
program that you want to export to and we don't yet support let us know. Go to 
feedback on how to contact us.

· EasyImport™ lets you import data from ASCII files and other applications. If you 
have a favorite program that you want to import data from and we don't yet 
support let us know. Go to feedback on how to contact us.

· Printing lets you print the data in any open EasyList or EasyLabel.
· Dialer, Send Email, Open URL/Web and Copy Postal Addresses: You can dial 

phone numbers directly from EasyManager under Windows 95 and Windows NT. 
You can send Email, open URL/Web addresses, and copy postal addresses to 
clipboard from within EasyManager.

· Right click context sensitive menus to access important information like phone 
numbers, email addresses, urls, and postal addresses from anywhere.



Overview of EasyManager

EasyManager assists you in managing personal information in many different ways. Before 
reading this section, please read the EasyManager Features.
Following are different types of objects that you can directly create, modify, view and delete.

· Person Object
· Business Object
· Account Object
· ToDo Object
· Reminder Object
· Group Object

An object consists of many different pieces of information associated with the given object. 
Each piece of information is considered as an attribute (sometimes referred as field) of the
object. For example, every object has a name by which it is identified. Thus the object is said
to have a name attribute. 
In general, you may not be interested in viewing all the attributes of the objects at one time.
In fact, you may want to group certain pieces of information (attributes) and view particular 
information of a particular type of object all at once. EasyLists let you view only the desired 
attributes of particular types of objects. For example, Person Tel/Fax List displays only the 
home and work Tel/fax numbers of Person objects.
A number of EasyLists have been pre-defined for your convenience to begin with. You may 
create new list definitions, may modify the definition of existing lists, or delete them if you 
do not need them. See Customizing EasyList for details.
You may edit any attribute that you can view in any EasyList. If a given attribute appears in 
more than one list, it is automatically updated to maintain consistency. 
You may select any one object in any EasyList. The selected object appears as a highlighted 
object within all the EasyLists/EasyLook that display it. The selected object is also displayed 
within the EasyEditor if the editor is open. See Selecting An Object on how to select any 
object. 
By default, a given EasyList displays all the objects of a given type that the list is designed 
to display. You may choose to filter the objects that you view in the list by specifying a filter 
criteria by defining an EasyFilter. and associating it with the EasyList.
The list by default is sorted by the first column. You can sort the objects in the list in any way
you want to by defining an EasySort, and associating it with the EasyList.
EasyEditor allows you to view and edit all the attributes of a given object. It changes its form
depending on the type of object that is being edited. 
You may create new objects either from within the EasyEditor, or within any EasyList. See 
Creating An Object on how to create new objects. 
You may delete any object by first selecting an object and then either selecting the delete 
menu item from the Edit menu, or by pressing Ctrl+D. Only a selected object can be 
deleted. See Deleting An Object on how to delete an object.
To improve user productivity, you may only enter partial information for many of the 



attributes, and the EasyFill facility will automatically complete the value. If the partial 
information that you enter does not resolve to any possible value, or resolves to more than 
one possible value, then you will be given a set of possible choices to select from.
EasyManager maintains significant amount of information on a given object. You may export 
a portion of the information to other programs by invoking EasyExport. The number of 
programs that you can export information to keeps on growing. Currently, you may export 
relevant attributes of all objects in the database or only the objects in a given EasyList to 
CompuServe Address Book, and List Data as Tab or Comma separated text file (which you 
can then export to many other programs like Spreadsheets and databases). 
You may Print any EasyList. The list will be printed exactly the way you see it on the screen.
There are times when you want to quickly and easily see a particular information on a given 
object quickly. This is specially true of postal addresses, telephone numbers, and electronic 
mail addresses. You can do this easily by invoking EasyLook. EasyLook allows you to enter a 
name pattern, and it displays the requested information of all the objects that match the 
name.
EasyLabel allows you to create, view and print the labels. You can also print address books 
by simply printing the labels on a plain sheet of paper. You can filter and sort the objects the 
same way you filter and sort EasyLists.
For added productivity, you can popup a context dependent menu by right clicking in the 
desired cell in EasyList and EasyLook. It also provides you with Dial and Email features.



Future Features Coming Soon

EasyManager is being enhanced continuously to do many more things. The idea is to make 
EasyManager as your preferred software for managing information and from which you can 
export it to other applications. This way you maintain consistency of data across many 
applications and the data is always available when you need it.
The following features are planned. If you would like to have a particular feature that is not 
mentioned here, let us know. See feedback on how to contact us.

· Calendar: To help you view important dates, birthdays, anniversaries, todo, 
reminders, etc. and to print calendar by month, year, and day.

· Envelope Printing: To print envelope with To/From addresses.
· Export objects to many other applications like On-line Services, Fax, Electronic 

mail, Mail Merge, Calendar and Label Generator programs. If you use a favorite 
program which you want to export data to, let us know. See feedback on how to 
contact us.



Introduction To Objects

In general terms, an Object is an encapsulation of certain pieces of related data and a 
certain behavior associated with that data. Human thinking and approach is object-oriented. 
We see things in terms of objects and associate certain characteristics and/or behavior with 
these objects.
EasyManager also models objects. There are six primary objects that you have direct control 
over their creation, deletion, modification and selection. These objects are:

· Person Object
· Business Object
· Account Object
· ToDo Object
· Reminder Object
· Group Object

Each of these objects represent an entity in our day-to day lives. Person object represents 
certain data of a person, and certain behavior is associated with it. For example, A Person 
may live with another person, persons have names, they are related to other persons, have 
a home and work address, and so on. Person objects are used to save personal information 
of friends, relatives, acquaintances, and so on.
Similarly, Business object represents an organization which has a postal address, phone 
number, electronic mail address. Business objects are used to store information on 
businesses. For example, you may want to store business information for your local drug 
store, shops, and so on.
Account objects represents the many accounts we have with different companies like 
newspaper and magazine subscription accounts, credit card accounts, bank accounts, 
services accounts (telephone, gas and electricity, garbage) and the like.
ToDo objects represents tasks that you need to do. The tasks can be anything, like call mom 
on a certain day, pickup dad from airport on a certain day, post rent. You can categorize the 
things to do into as many categories as you want to - like Work, Social, Household, and the 
like. You decide the categories and you create these categories. Some ToDo objects are 
created automatically, like from Reminder objects when it is time to remind of a given event,
and from Person objects when a birthday or a marriage anniversary is approaching.
Reminder objects represent events that you want to be reminded of a few days before they 
occur. Events can be regularly recurring, or could be just a one-time event. Reminder objects
track the event and when they will occur, and when you want to be reminded of. When it is 
time to remind, the reminders are entered into the ToDo lists as a ToDo object.
In our day-to-day lives, we group set of related objects. The objects can be related in many 
ways. For example, we may group persons who live in a particular state - like all friends who 
live in California. The Group object is used to group Person, Business, Account, ToDo and 
other Group objects together.
There are many other objects within EasyManager that you do not directly have control over.
That is, you cannot independently refer to these objects. They exist only in the context of a 
primary object as mentioned above. These objects exists as long as the primary object to 
which they belong also exists. These objects are: 



· Postal Address Object
· Electronic Mail Address Object
· Phone Object

Postal address object has the street address, city, state, zip and country attributes. A postal 
address object is used to keep home and work address for Persons and address for 
Businesses.
Electronic Mail address object is used to keep electronic mail address, address type and 
additional comments. This object is used to keep electronic mail address of Persons and 
Businesses.
Phone object is used to keep phone numbers. It is used for home and work phone numbers 
and fax numbers of Persons, and phone and fax numbers of Businesses.



Person Object

Person object is designed to keep personal information of a person. The following 
information can be stored for any person. The names in parenthesis are the internal names 
used to refer the attributes internally.

Id (id)

Title (title)
Name (name)
Last Name (lastName)
First Name (firstName)
Middle Name (middleName)
Alias (alias)

Living With (livingWith)
Home Address (homeAddress)
Home Telephone Number (homeTelSet)
Home Fax Number (homeFaxSet)

Working With (workingWith)
Company Name (companyName)
Work Address (workAddress)
Work Telephone Number (workTelSet)
Work Fax Number (workFaxSet)

Alternate Address (altAddress)

Email Addresses (emailSet)
Url/Web Addresses (urlSet)

Sex (sex)
Birth Date (birthDate)
Marriage Date (marriageDate)

Father (father)
Mother (mother)
Spouse (spouse)
Children (children)
Belongs To Groups (groupSet)
Text1...N (text1, ...textN)
Num1...N (num1, ...numN)
Date1...N (date1, ...dateN)



Person: Id

Every object is identified internally by EasyManager with an id. Person objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database.

See Also
Person Object.



Person: Name (name)
Person: Last Name (lastName)
Person: First Name (firstName)
Person: Middle Name (middleName)

Name is the primary attribute that is used to identify the person. You can define more than 
one person with the same name, but it is not advisable to do so as it may create confusion 
while exporting the object to other applications. When creating an object, if another object 
by the same name already exists, EasyManager will give you a warning.
You must enter the name with first name first, then the middle name if any, and then the 
last name.
The name is internally split up into three parts - Last Name, First Name and Middle 
Name. The first word in a name is taken as the first name, the last word is taken as the last 
name, and the rest is taken as the middle name.

See Also
Person Object.



Person: Title (title)

Title is the salutation that should be used for the particular person. Some examples of 
salutations are: Mr., Mrs., Miss, Dr., and Prof. This field is useful while printing address labels.

See Also
Person Object.



Person: Alias (alias)

Alias is another name of the person by which the person may be identified. Normally alias is 
used to identify persons while exporting data to other applications. For example, when 
exporting electronic mail addresses in the UNIX .mailrc format, alias of the person is used to 
identify the person by default. If alias of the person is not specified, then the Name is used 
for identification.

See Also
Person Object.



Person: Birth Date (birthDate)

This is the date the person was born. You enter the date using Windows date format settings.
Remember to enter the year with the century (e.g.: 1996 is correct, whereas 96 is not). See 
Editing Date Value on various ways to enter date values.

See Also
Person Object
Editing Date Value



Person: Marriage Date (marriageDate)

This is the date the person was married. You enter the date using Windows date format 
settings. Remember to enter the year with the century (e.g.: 1996 is correct, whereas 96 is 
not).. Editing Date Value on various ways to enter date values.

See Also
Person Object
Editing Date Value



Person: Sex (sex)

This attribute specifies the sex of the person. There are two possible choices, Male and 
Female. 
You can use the EasyFill feature to enter the value. i.e. you only need to type enough 
number of character to identify the value uniquely. In this case, you need to only type f or F 
and press return for Female and type m or M and press return for Male.

See Also
Person Object 
EasyFill 



Person: Living With (also Share Home Address With) (livingWith)

This attribute is used to denote if the given person is living with another person. A person is 
said to be living with another person if he/she shares the home address with that person.
If the person is living with another person, then you may want to specify the name of the 
person with whom this person is living with. This way the home address and (optionally 
home telephone and fax numbers depending on the Preferences) are shared between all 
the persons living together. When you change the home address of one, the change is 
reflected for all the persons living together. This helps in eliminating redundancy in 
information, and at the same time automatically maintain data consistency. 
EasyFill feature is active for this attribute. You need to only type in enough number of 
characters to identify the name uniquely. The EasyFill feature will be complete the name for 
you. If you type in the name which matches more than one person's name or does not 
match any name at all, a selection box will be displayed for you to make a choice.
Detailed Explanation
Normally, at a given home address, there is one person who is designated as the primary 
person who is said to be living there. Rest of the persons live with the primary person. You 
would select any one person amongst all the person who are living at the given home 
address to be the primary person. Typically, the head of the household will be the primary 
person with whom rest of the persons (like spouse, and children) will be living with. So the 
head of the household does not live with anyone, but others live with him or her. 
You can change the primary person with whom rest of the people are living with by making 
the primary person live with someone else who is living there.
For example, lets say Jane, Bill and Mike were living with Joe. That means that Joe is the 
primary person living at the given home address, and the Living With attribute is empty for
Joe. Now, lets say you make Joe live with Jan. Then automatically Bill and Mike will also be 
updated to live with Jane and Jane will become the primary person living at the given home 
address. 
As another example, lets say Jane, Bill and Mike were living with Joe at a given home 
address. Now, if Joe is then edited such that Joe now lives with Andy the following action will 
take place. 

· If Andy was already living at a given address, then Joe, Jane, Bill and Mike will 
also have the same home address as Andy. 

· If Andy's home address was not yet specified but you have already specified the
address of Joe (or Jane or Bill or Mike), then Andy will also share the same home 
address as Joe, and will also become the primary person living at that home 
address. 

See Also
Person Object 
Person: Living Together

EasyFill
Preferences Dialog



Person: Living Together (livingSet)

This is a read-only attribute which is automatically updated to show who all are living with 
the given person. This attribute is obsolete, and cannot be viewed or accessed by the user.
See Also

Person Object 
Person: Living With



Person: Home Address (homeAddress)

This attribute specifies the home address of the person. See description of Postal Address to 
understand different attributes that completely specify a home address. 

See Also
Person Object 
Postal Address 



Person: Home Telephone Numbers (homeTelSet)

This is a set of telephone numbers of the person. You may specify as many telephone 
numbers as you need to. See description of Phone Object to understand different attributes 
that completely specify a telephone number. 

See Also
Person Object 
Phone Object 



Person: Home Fax Numbers (homeFaxSet)

This is a set of fax numbers of the person. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number. 

See Also
Person Object 
Phone Object 



Person: Working With (also Share Work Address With) (workingWith)

This attribute is used to denote if the given person is working at the same place as someone
else. A person is said to be working at the same place as another person if he/she is working
for the same company, and has the same work address.
If the person is working at the same place with another person, then you may want to 
specify the name of the person with whom this person is working with. This way the work 
address and (optionally work telephone and fax numbers depending on your Preferences) 
are shared across all the persons working together. When you change the address of one, 
the address change is reflected for all the persons working together. This helps in 
eliminating redundancy in information, and at the same time automatically maintain data 
consistency.
EasyFill feature is active for this attribute. You only need to type in enough number of 
characters to identify the name uniquely. The EasyFill feature will complete the name for 
you. If you type in the name which matches more than one person's name or does not 
match any name at all, a selection box will be displayed for you to make a choice.
Detailed Explanation
Normally, at a given work address, there is one person who is designated as the primary 
person who is working there. Rest of the person work with the primary person. You can 
choose any one person to be the primary person who is working at the given address, and 
the rest of the persons share the company name and work address with this person.
You can change the primary person with whom rest of the people are working with by 
making the primary person work with someone else. 
For example, lets say Jane, Bill and Mike were working with Joe. That means that Joe is the 
primary person working at the given work address, and the Working With attribute is 
empty for Joe. Now, lets say you make Joe work with Jan. Then automatically Bill and Mike 
will also be updated to work with Jane and Jane will become the primary person working at 
the given work address. 
As another example, lets say Jane, Bill and Mike were working with Joe at a given work 
address. Now, if Joe is then edited such that Joe now works with Andy the following action 
will take place. 

· If Andy was already working at a given company and work address, then Joe, 
Jane, Bill and Mike will also have the same company name and work address as 
Andy. 

· If Andy's company name and work address was not yet specified but you have 
already specified the company name and work address of Joe (or Jane or Bill or 
Mike), then Andy will also share the same company name and work address as 
Joe, and will also become the primary person working at that work address. 

See Also
Person Object
Person: Company Name
Person: Working Together

EasyFill



Preferences Dialog



Person: Working Together (workingSet)

This is a read-only attribute which is automatically updated to show who all are working with
the given person, .i.e. sharing the same company name and the work address as the given 
person.

See Also
Person Object 
Person: Company Name
Person: Working With



Person: Company Name (companyName)

This attribute specifies the company name where the person is working. If the person is 
working (sharing work address) with some other person or other persons are working with 
this person, then changing the company name will change the company name of all the 
persons working together.

See Also
Person Object 
Person: Working With
Person: Working Together



Person: Work Address (workAddress)

This attribute specifies the work address of the person. See description of Postal Address 
to understand different attributes that completely specify a work address.
If the person is working (sharing work address) with some other person or other persons are 
working with this person, then changing the work address will change the work address of all
the persons working together.

See Also
Person Object 
Person: Working With
Person: Working Together
Postal Address 



Person: Work Telephone Numbers (workTelSet)

This is a set of telephone numbers of the person. You may specify as many telephone 
numbers as you need to. See description of Phone Object to understand different attributes 
that completely specify a telephone number. 

See Also
Person Object 
Phone Object 



Person: Work Fax Numbers (workFaxSet)

This is a set of fax numbers of the person. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number. 

See Also
Person Object 
Phone Object 



Person: Working At

This is the place of work of the person. You can specify one work address of a person. The 
work address is another object called the Business Object. You specify an already existing 
business object name as the place of work or you can create a new business object. 
Business objects are separate objects that can exist on their own once created. Also, more 
than one person could be working at the same place, thus you can share the same business 
object. This way you eliminate redundant specification of business address etc. and at the 
same time maintain consistency automatically.
See description of Business Object for details. You specify Business Object by Company 
Name. You only need to type enough characters to identify the business company name 
uniquely. EasyFill feature will complete the name for you.

See Also
Person Object 
Business Object 
EasyFill 



Person: Alternate Address (altAddress)

This attribute specifies an alternate address of the person. This is provided to keep an 
additional address associated with the person other than home and work addresses. See 
description of Postal Address to understand different attributes that completely specify 
alternate address.
Alternate addresses are not shared by other people.

See Also
Person Object 
Postal Address 



Person: Email Addresses (emailSet)

This is a set of electronic mail addresses of a person. You can specify as many electronic 
mail addresses of a person as you need to. See description of Email Address Object to 
understand different attributes that specify the electronic mail address. 

See Also
Person Object 
Email Address Object 



Person: Url/Web Addresses (urlSet)

This is a set of internet addresses commonly known as the URL (Uniform Resource Locator) 
addresses, also called the Web addresses of a person. You can specify as many URL/Web 
addresses of a person as you need to. See description of Url Address Object to understand 
different attributes that specify the Url address. 

See Also
Person Object 
Url Address Object 



Person: Father (father)

This is another Person Object who is the father of the person. You specify the father by 
typing the name of the father.
You only need to type as many characters as to uniquely specify the name. EasyFill feature 
will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Mother (mother)

This is another Person Object who is the mother of the person. You specify the mother by 
typing the name of the mother.
You only need to type as many characters so as to uniquely specify the name. EasyFill 
feature will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Spouse (spouse)

This is another Person Object who is the spouse of the person. You specify the spouse by 
typing the name of the spouse.
You only need to type as many characters so as to uniquely specify the name. EasyFill 
feature will complete the rest of the name for you. 

See Also
Person Object 
EasyFill 



Person: Children (children)

This is a set of Person Objects who are children of the person. Child/parent relationship is 
automatically set when you either set the father, mother or children attributes.

See Also
Person: Father
Person: Mother
Person Object 



Belongs To Groups (groupSet)

This is a set of Group Objects to which the Person belongs. A person can belong to as many 
groups as you desire.

See Also
Group Object 
Person Object 



Person: Text1...N (text1,...textN)

There are Text1 to TextN attributes of a Person that can be used to store any information that
you wish to keep along with the Person Object.

See Also
Person Object 



Person: Num1...N (num1,...numN)

There are Num1 to NumN attributes of a Person that can be used to store any integer valued
information that you wish to keep along with the Person Object.

See Also
Person Object 



Person: Date1...N (date1,...dateN)

There are Date1 to DateN attributes of a Person that can be used to store any additional 
dates that you wish to keep along with the Person Object.

See Also
Person Object 



Business Object

Business Object is designed to keep information of businesses, may it be a place of work, 
place where you go out to eat, a travel agency, entertainment company, or anything else 
which is an organization. A business object has the following attributes that you can specify. 
The names in parenthesis are the internal names used to refer the attributes internally.

Id
Company Name (businessName)
Additional Name (additionalName)
Address (address)
Telephone Numbers (telSet)
Fax Numbers (faxSet)
Email Addresses (emailSet)
Url/Web Addresses (urlSet)
Comments (comments)
Belongs To Groups (groupSet)
Text1...N (text1,...textN)



Business: Id

Every object is identified internally by EasyManager with a id. Business objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database. 

See Also
Business Object 



Business: Company Name (businessName)

Company Name is the primary attribute that is used to identify a business. You can define 
more than one business with the same company name, but it is not advisable to do so as it 
may create confusion while exporting the object to other applications. When creating an 
object, if another object by the same name already exists, EasyManager will give you a 
warning. 

See Also
Business Object 



Business: Additional Name (additionalName)

This attribute can be used to specify a division, a department etc. that identifies a part of 
the company. For example, you may want to keep two different business objects one for the 
Technical Support, another for the Sales Department of one company because they are 
located on different street address.
If the only thing that you want to store for a company is telephone and fax numbers, and/or 
electronic mail addresses then you can just have one business and store many telephone or 
fax numbers or electronic mail addresses each one with a specific comment which 
department it is for. 

See Also
Business Object 



Business: Address (address)

This specifies the postal address of the business. See description of Postal Address to 
understand different attributes that completely specify the street address. 

See Also
Business Object 
Postal Address Object 



Business: Telephone Numbers (telSet)

This is a set of telephone numbers of the business. You may specify as many numbers as 
you need to. See description of Phone Object to understand different attributes that 
completely specify a telephone number.

See Also
Business Object 
Phone Object 



Business: Fax Numbers (faxSet)

This is a set of fax numbers of a business. You may specify as many fax numbers as you 
need to. See description of Phone Object to understand different attributes that completely 
specify a fax number.

See Also
Business Object 
Phone Object 



Business: Email Addresses (emailSet)

This is a set of electronic mail addresses of a business. You can specify as many electronic 
mail addresses of a business as you need to. See description of Email Address Object to 
understand different attributes that specify the electronic mail address.

See Also
Business Object 
Email Address Object 



Business: Url/Web Addresses (urlSet)

This is a set of internet addresses of a business, known as URL (Uniform Resource Locator) or
Web addresses. You can specify as many Url/Web addresses as you need to. See description 
of Url Address Object to understand different attributes that specify the url/web address.

See Also
Business Object 
Url Address Object 



Business: Comments (comments)

This attribute can be used to store any other information that could not be stored in any of 
the attributes explicitly.

See Also
Business Object 



Business: Belongs To Groups (groupSet)

This is a set of Group Objects to which the Business Object belongs. A business can belong 
to as many groups as you desire.

See Also
Business Object 
Group Object 



Business: Text1...N (text1,...textN)

Attributes Text1 to TextN can be used to store any other information that you desire, but 
could not be stored in any of the other attributes explicitly.

See Also
Business Object 



Account Object

An Account object is used to store information related to an account. An account can be 
anything including, but not limited to a bank, credit card, subscription or club account. This 
object provides special attributes that store account specific information like account 
number, access code, etc.
There is very little difference between a business object and an account object except that 
account object is designed to store account specific information also.
The following attributes are defined for the Account objects. The names in parenthesis are 
the internal names used to refer the attributes internally.

Id
Account Name (accountName)
Description (description)
Account Type (accountType)
Account Number (accountNumber)
Access Code (accessCode)
Expiration Date (expirationDate)
Customer Service Telephone Numbers (custSrvTelSet)
Automated Access Telephone Numbers (autoAccessTelSet)
Fax Numbers (faxSet)
Address (address)
Email Addresses (emailSet)
Url/Web Addresses (urlSet)
Comments (comments)
Belongs To Groups (groupSet)
Text1...N (text1,...textN)



Account: Id

Every object is identified internally by EasyManager with a id. Account objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database. 

See Also
Account Object 



Account: Account Name (accountName)

Account Name is the primary attribute that is used to identify an account. You can define 
more than one account with the same account name, but it is not advisable to do so as it 
may create confusion while exporting the object to other applications. When creating an 
object, if another object by the same name already exists, EasyManager will give you a 
warning. 

See Also
Account Object 



Account: Description (description)

This attribute can be used to describe the account.

See Also
Account Object 



Account: Account Number (accountNumber)

This attribute can be used to store the account number of the given account.

See Also
Account Object 



Account: Access Code (accessCode)

This attribute can be used to store the access code of the given account.

See Also
Account Object 



Account: Account Type (accountType)

This attribute can be used to store the type of account. Currently, the account types can be 
of the following:

· Bank Use this type if you are creating an bank account
· Credit Card Use this type if you are creating a credit card account
· Check Card Use this type if you are creating a check card account
· Debit Card Use this type if you are creating a debit card account
· Subscription Use this type if you are creating a subscription account
· Investment Use this type if you are creating a investment account
· Pay By PhoneUse this type if you are creating a pay-by-phone account
· Login/Web Use this type if you are creating a login/web account
· Calling Card Use this type if you are creating a calling card account
· Membership Use this type if you are creating a membership account
· Insurance Use this type if you are creating a insurance account
· Other Use this type if you are creating an account that does not fall in 

any other category
You only need to enter enough number of characters to uniquely specify the type. EasyFill 
feature will complete rest of the type name for you.

See Also
Account Object 
EasyFill



Account: Expiration Date (expirationDate)

This is the date the account expires. You enter the date using Windows date format settings. 
Remember to enter the year with the century (eg: 1996 is correct, whereas 96 is not).. See 
Editing Date Value on various ways to enter date values.

See Also
Account Object 
Editing Date Value



Account: Address (address)

This specifies the postal address of the account. See description of Postal Address to 
understand different attributes that completely specify the street address. 

See Also
Account Object 
Postal Address Object 



Account: Customer Service Telephone Numbers (custSrvTelSet)

This is a set of customer service telephone numbers of the account. You may specify as 
many numbers as you need to. See description of Phone Object to understand different 
attributes that completely specify a telephone number.

See Also
Account Object 
Phone Object 



Account: Automated Access Telephone Numbers (autoAccessTelSet)

This is a set of automated access telephone numbers of the account. You may specify as 
many numbers as you need to. See description of Phone Object to understand different 
attributes that completely specify a telephone number.

See Also
Account Object 
Phone Object 



Account: Fax Numbers (faxSet)

This is a set of fax numbers of a account. You may specify as many fax numbers as you need
to. See description of Phone Object to understand different attributes that completely 
specify a fax number.

See Also
Account Object 
Phone Object 



Account: Email Addresses (emailSet)

This is a set of electronic mail addresses of the account. You can specify as many electronic 
mail addresses as you need to. See description of Email Address Object to understand 
different attributes that specify the electronic mail address.

See Also
Account Object 
Email Address Object 



Account: Url/Web Addresses (urlSet)

This is a set of internet addresses of the account, also known as URL (Uniform Resource 
Locator) addresses or Web addresses. You can specify as many url/web addresses as you 
need to. See description of Url Address Object to understand different attributes that specify 
the url/web address.

See Also
Account Object 
Url Address Object 



Account: Comments (comments)

This attribute can be used to store any other information that could not be stored in any of 
the attributes explicitly.

See Also
Account Object 



Account: Belongs To Groups (groupSet)

This is a set of Group Objects to which the Account Object belongs. A account can belong to 
as many groups as you desire.

See Also
Account Object 
Group Object 



Account: Text1...N (text1,...textN)

Attributes Text1 to TextN can be used to store any other information that you desire, but 
could not be stored in any of the other attributes explicitly.

See Also
Account Object 



ToDo Object

ToDo object is used to track things to do, commonly known as ToDo list. You create ToDo 
objects to track almost anything that you need to remember to do or to keep your list of 
things to do organized.
Following attributes are defined for ToDo Objects:

Id
Description (description)
Priority (priority)
ToDo On Date (toDoOnDate)
Status (status)
Date Completed (dateCompleted)
Belongs To Groups (groupSet)
Comments (comments)
Text1...N (text1,...textN)



ToDo: Id

Every object is identified internally by EasyManager with a id. ToDo objects also are assigned
an id automatically as soon as the object is created. The id of an object is unique within a 
database.

See Also
ToDo Object 



ToDo: Description (description)

This is the primary attribute that is used to identify a ToDo object. You can define more than 
one ToDo object with the same description but it is not advisable to do so as it may create 
confusion while exporting the object to other applications. When creating an object, if 
another object by the same description already exists, EasyManager will give you a warning.

See Also
ToDo Object 



ToDo: Priority (priority)

This attribute is used to denote the priority of the task represented by the ToDo object. A 
priority is denoted by a positive number. By default every task is assigned a priority of zero. 
You can specify any priority number you want to. This attribute is useful in sorting the tasks 
by priority so you can concentrate on the high priority tasks first.

See Also
ToDo Object 



ToDo: ToDo On Date (toDoOnDate)

This is the date to do the task on. You enter the date using Windows date format settings. 
Remember to enter the year with the century (eg: 1996 is correct, whereas 96 is not).. See 
Editing Date Value on various ways to enter date values.

See Also
ToDo Object 
Editing Date Value



ToDo: Status (status)

This attribute is used to denote the status of the task represented by the ToDo object. Status
can be one of the following:

· Pending Denotes the task is pending
· In Progress Denotes the task is in progress
· On Hold Denotes the task is on hold
· Completed Denotes the task has been completed

Setting the status to Completed also sets the Date Completed attribute to the current 
date (the date when the task was completed).
You only need to enter enough number of characters to uniquely specify the status. EasyFill
feature will complete rest of the status name for you.

See Also
ToDo Object 
EasyFill



ToDo: Date Completed (dateCompleted)

This is the date the task was completed. This attribute is set automatically when the task 
status changes to Completed. If the status is not completed, and a date is entered for this 
attribute, the status is changed to Completed.
You enter the date using Windows date format settings. Remember to enter the year with 
the century (eg: 1996 is correct, whereas 96 is not).. See Editing Date Value on various 
ways to enter date values.

See Also
ToDo Object 
ToDo: Status 
Editing Date Value



ToDo: Belongs To Groups (groupSet)

This is a set of Group Objects to which the ToDo Object belongs. This is used to categorize 
the tasks (ToDo objects) into different categories. For instance you could define groups 
(categories) like Work, Social, School, etc. and assign ToDo objects to these groups 
(categories). A ToDo object can belong to as many categories as you want to.

See Also
ToDo Object 
Group Object 



ToDo: Comments (comments)

This attribute can be used to store any other information that is associated with the ToDo 
object. 

See Also
ToDo Object 



ToDo: Text1...N (text1,..., textN)

Attributes Text1 to TextN can be used to store any other information that you desire, but 
could not be stored in any of the other attributes explicitly.

See Also
ToDo Object 



Reminder Object

Reminder objects are used to track tasks to remind at a predetermined date. The tasks can 
be anything, and you create a reminder object for each task you want to be reminded of. 
Tasks can be recurring (ie.e they repeat every fixed internal like every week, month, year), 
or occur once only. Some example of tasks are - like Attend Seminar on Jan 20, 1996, or Mail 
Rent On 1st of every month, or Pay Gardener every week.
When the time comes near for the task to do, EasyManager automatically creates a ToDo 
object to represent the task, so you can see it in the ToDo list alongwith other tasks. 
EasyManager also updates the Next Date attribute of the Reminder object to be the next 
date depending on the frequency.
Following attributes are defined for Reminder Objects:

Id
Description (description)
Next Date (nextDate)
Frequency (frequency)
Days Before To Remind (numDaysBefore)
Comments (comments)
Text1...N (text1,...textN)



Reminder: Id

Every object is identified internally by EasyManager with a id. Reminder objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database.

See Also
Reminder Object 



Reminder: Description (description)

This is the primary attribute that is used to identify a Reminder object. You can define more 
than one Reminder object with the same description but it is not advisable to do so as it may
create confusion while exporting the object to other applications. When creating an object, if
another object by the same description already exists, EasyManager will give you a warning.

See Also
Reminder Object 



Reminder: Next Date (nextDate)

This is the date the task is to be performed. The date to remind is computed as this date 
minus the number of Days Before To Remind attribute value.
You enter the date using Windows date format settings. Remember to enter the year with 
the century (eg: 1996 is correct, whereas 96 is not).. See Editing Date Value on various 
ways to enter date values.

See Also
Reminder Object 
Editing Date Value



Reminder: Frequency (frequency)

This attribute is used to denote how often the task needs to be reminded, i.e. how often 
does the task repeat. Frequency can be one of the following:

· Never Denotes the task is not to be reminded.
· Once Denotes the task is to be reminded only once. After reminding, 

EasyManager changes the Frequency to Never.
· Every Day Denotes the task is to be reminded every day. After reminding, 

EasyManager changes the Next Date to one day after the 
current date.

· Every Week Denotes the task is to be reminded every week. After reminding, 
EasyManager changes the Next Date to one week after the 
current date.

· Every Two Weeks Denotes the task is to be reminded every two weeks. 
After reminding, EasyManager changes the Next Date to two 
weeks after the current date.

· Twice A Month Denotes the task is to be reminded twice every month. 
After reminding, EasyManager changes the Next Date to remind 
15 days (adjusted according to number of days in a month) after 
the current date.

· Every Month Denotes the task is to be reminded every month. After reminding,
EasyManager changes the Next Date to one month after the 
current date.

· Every Quarter Denotes the task is to be reminded every quarter. After 
reminding, EasyManager changes the Next Date to three months
after the current date.

· Every Year Denotes the task is to be reminded every year. After reminding, 
EasyManager changes the Next Date to one year after the 
current date.

You only need to enter enough number of characters to uniquely specify the Frequency. 
EasyFill feature will complete rest of the status name for you.

See Also
Reminder Object 



Reminder: (Number Of) Days Before To Remind (numDaysBefore)

This attribute is used to denote the the number of days before the task is to be done, you 
would like EasyManager to remind you of the task. EasyManager creates a ToDo object 
corresponding to the task to remind on the date which is the Next Date the task is due 
minus the number of days before you want to be reminded.

See Also
Reminder Object 



Reminder: Comments (comments)

This attribute can be used to store any other information that is associated with the 
Reminder object.

See Also
Reminder Object 



Reminder: Text1...N (text1,..., textN)

Attributes Text1 to TextN can be used to store any other information that you desire, but 
could not be stored in any of the other attributes explicitly.

See Also
Reminder Object 



Group Object

A Group Object is designed to organize individual objects like Person, Business, Account, 
ToDo and Reminder, in specific purpose groups.
For example, you may want to define a group for friends in California. Any object can be a 
member of the group. An object can be part of any number of groups. A group can contain 
other groups as long as the groups do not form a cycle. This allows you to organize your 
groups hierarchically. For example you could have a group of fax numbers for each state in 
USA, and then have a group of fax numbers for the all of USA.
Following attributes are defined for Group Objects:

Id
Name (name)
Members (members)
Comments (comments)
Text1...N (text1,...textN)

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 



Group: Id

Every object is identified internally by EasyManager with a id. Group objects also are 
assigned an id automatically as soon as the object is created. The id of an object is unique 
within a database.

See Also
Group Object 



Group: Name (name)

This is the primary attribute that is used to identify a group. You can define more than one 
group with the same name but it is not advisable to do so as it may create confusion while 
exporting the object to other applications. When creating an object, if another object by the 
same name already exists, EasyManager will give you a warning. 

See Also
Group Object 



Group: Members (members)

This is a set of objects that constitute the group. The objects can be of any type. Currently, 
objects of type Person, Business or Group can be members of the group. A object can be a 
member of many groups.
A group can be a member of another group as long as the group does not form a cycle. For 
example, If Group A contains Group B, and Group B contains Group C. Then if Group C or 
Group B contains group A a cycle will be formed. 

See Also
Group Object 
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 



Group: Comments (comments)

This attribute can be used to store any other information that is associated with the group. 

See Also
Group Object 



Group: Text1...N (text1,..., textN)

Attributes Text1 to TextN can be used to store any other information that you desire, but 
could not be stored in any of the other attributes explicitly.

See Also
Group Object 



Postal Address Object

Postal Address object is used to keep the street address. The street address can be shared 
by many different types of objects that have a postal address. Currently, objects of type 
Person and Business have a postal address. The following components of the address can be
stored.

Street (street)
Street2 (street2)
City (city)
State (state)
Zip (zip)
Country (country)
Directions (directions)

See Also
Person Object 
Business Object 
Account Object 



Postal Address: Street (street)

This is the first line of street name and number. You may include the suite or apartment 
number in this attribute. You may want to follow a convention of specifying the suite or 
apartment number by preceding the number by a '#' sign.

See Also
Postal Address Object 



Postal Address: Street2 (street2)

This is the 2nd line for specifying the street. You may include the suite or apartment number 
in this attribute. You may want to follow a convention of specifying the suite or apartment 
number by preceding the number by a '#' sign.

See Also
Postal Address Object 



Postal Address: City (city)

This is the city part of the postal address. 

See Also
Postal Address Object 



Postal Address: State (state)

This is the state part of the postal address. Normally, you may want to follow a convention 
on how to enter state names. For example, if you decide you use CA as the sate name for 
California, then use it everywhere you want to specify California.

See Also
Postal Address Object 



Postal Address: Zip (zip)

This is the zip code of the postal address. You can use any characters to represent the zip 
code. Some countries have zip codes containing digits only, others have a combination of 
letters and digits.

See Also
Postal Address Object 



Postal Address: Country (country)

This is the country of the postal address.

See Also
Postal Address Object 



Postal Address: Directions (directions)

This attribute can be used to keep the directions on how to get to the given postal address.

See Also
Postal Address Object 



Electronic Mail Address Object

Electronic Mail Address or Email address is the electronic address that is used to send and 
receive electronic mail. Depending on what electronic mail service you use, you would have 
a different format of specifying the address.    Electronic Mail Address Object has the 
following attributes:

Address (emailAddress)
Type (emailType)

See Also
Person Object 
Business Object 
Account Object 



Email Address: Address (emailAddress)

Attribute is used to keep the electronic mail address in the native form.
For example, if the person has a CompuServe address, specify the address as a CompuServe
address and not as an internet address. This is important so that you can export the 
addresses to different applications more easily. For example, if you export the addresses to 
CompuServe Information Manager, then EasyManager will export the CompuServe address 
as a CompuServe address, if you export the addresses to be used with UNIX mailer, then 
EasyManager will correctly translate the CompuServe address to an equivalent internet 
form.

See Also
Email Address Object 



Email Address: Type (emailType)

This attribute represents the type or format in which the electronic mail address is specified. 
Currently the following types are valid types. 

· Internet Use this type if you are specifying an internet address
· CompuServe Use this type if you are specifying a CompuServe address
· MCI Mail Use this type if you are specifying a MCI Mail address
· America Online Use this type if you are specifying America Online 

address
· Prodigy Use this type if you are specifying Prodigy address

If the address type you have is not supported, then specify it as an internet address. Most 
mailers support sending mail to an internet address.
You only need to enter enough number of characters to uniquely specify the type. EasyFill 
feature will complete rest of the type name for you.

See Also
Email Address Object 
EasyFill



Url Address Object

Url or Web Address is the internet address used to open up web addresses in the Web 
browsers. Url Address Object has the following attributes:

Address (urlAddress)
Comments (comments)

See Also
Person Object 
Business Object 
Account Object 



Url Address: Address (urlAddress)

Attribute is used to keep the url/web address in the native form. Specify complete url 
address.

See Also
Url Address Object 



Url Address: Comments (comments)

This is used to specify a comment. You can write any comment associated with the Url 
Address. It is specially useful if you have more than one url address and you want to note 
down what each address is for.

See Also
Url Address Object 



Phone Object

Phone object is used to store a phone number, may it be a telephone number, fax number, 
or automated information numbers. The following details can be stored for a phone:

Number (phoneNumber)
Country Code (countryCode)
Area Code (areaCode)
Local Number (localNumber)
Extension (extension)
Comments (comments)

See Also
Person Object 
Business Object 
Account Object 



Phone: Number (phoneNumber)

This is used to specify the number. The number can be entered as digits, or as a 
combination of digits and alphabets. You can use any character as a separator except [] (). 
Commonly used separators are dash '-', dot '.' and space. Normally you may want to reserve
a comma ',' for denoting a pause.
You may directly enter the phone number in the following format:
[countryCode] (areaCode) localNumber x extension
EasyManager automatically splits the phone number and assigns it as different components 
of the phone. You may also enter the phone number components individually using the 
Country Code, Area Code, Local Number, and Extension attributes.
Do not enter dialing prefix with the phone number.

See Also
Phone Object 
Country Code 
Area Code 
Local Number 
Extension 



Phone: Country Code (countryCode)

This is used to specify the country code part of the phone number. You should not enclose 
the country code within square brackets when entering. EasyManager will add the 
appropriate parenthesis as needed.
The country code should be entered as digits.
You may also enter the complete phone number using the phoneNumber attribute.

See Also
Phone Object 
Phone Number 



Phone: Area Code (areaCode)

This is used to specify the area or city code part of the phone number. You should not 
enclose the area code within parenthesis when entering. EasyManager will add the 
appropriate parenthesis as needed.
The area code could be entered as digits or alphabets.
You may also enter the complete phone number using the phoneNumber attribute.

See Also
Phone Object 
Phone Number 



Phone: Local Number (localNumber)

This is used to specify the local number (wthin your local dialing area) part of the phone 
number. You should not specify the area code as part of the local number.
The local number can be entered as digits or alphabets.
You may also enter the complete phone number using the phoneNumber attribute.

See Also
Phone Object 
Phone Number 



Phone: Extension (extension)

This is used to specify the extension (if any) part of the phone number. Extension can be 
entered as digits or alphabets.
You may also enter the complete phone number using the phoneNumber attribute.

See Also
Phone Object 
Phone Number 



Phone: Comments (comments)

This is used to specify a comment. You can write any comment associated with the number. 
It is specially useful if you have more than one number and you want to note down what 
each number is for.

See Also
Phone Object 



Creating An Object

You create an object either in a EasyList or within the EasyEditor. 

Creating Object Within EasyList
Within EasyList, you can only create an object of the type that the list handles. For example, 
Home Telephone Numbers List shows attributes of Person object. Thus you can only create 
objects of Person type in this list. 
The last row of any editable EasyList is always empty. Entering the name in the name 
column of the last row automatically creates an object of the given type. 

Creating Object Within EasyEditor
To create an object from the EasyEditor, follow these steps: 

1. Make sure that no object is currently selected. EasyEditor always displays the 
selected object if there is a selected object. If there is no currently selected 
object, you can skip this step. Pressing the "New Object" button clears the 
selection if any and grays out all the attributes except the first attribute. 

2. Press the "Type" button. This will give you a choice of the type of objects that 
you can create. If the type of object you want to create is already being 
displayed in the editor, then you can skip this step. Select the type of object you
want to create. 

3. Enter the name of the object. Entering a name automatically creates an object 
of the given type. Also, all other attributes will also become available for editing.

Note, that this style of creating an object is very different than other software where you 
have to press an "Apply" or a "Create" button to create an object.

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 
Group Object 



Selecting An Object

You may select an Object from any EasyList or from the EasyEditor. An object once selected, 
appears selected wherever it is displayed.

Selecting Object Within EasyList
From the EasyList, clicking on the left most cell of a row will select that object. This cell 
displays the Id of the object.
Or
You may also select by clicking right mouse button within the row of the object that you 
want to select, and choosing the Select menu item from the context dependent popup menu
that pops up.
Selecting Object Within EasyEditor
From the EasyEditor, you can select an object by following the steps below:

1. Choose the type of object you want to select. If the type of object you want to 
select is already displayed in the editor, you can skip this step. Press the "Type" 
button, and it will display a selection box with a list of all the possible types of 
objects. Double click on the type you want, or click once, and then press the OK 
button. 

2. Press the "Sel... " button at the bottom of the editor. This will display a selection 
box with the name of all the objects of the given type. Click on the object you 
want to select, and then press OK. Double clicking on the object you want to 
select is equivalent to clicking once and then pressing OK button.
Or

3. Press the First (<<), Last (>>), Next (>) or Previous (<)    buttons. This will 
select the first, last, next or previous object as appropriate.
Or

4. Enter the name that you want to select in the Find box and press return. You 
may enter only partial name. If the name matches an object uniquely, that 
object will be selected. If the name matches more than one object or if it does 
not match any object, a selection box will be displayed to select from.

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 
Group Object 



Editing An Object

You can edit an object anywhere it is displayed. All the attributes of an object can be edited 
in the EasyEditor. You can also edit any attribute of the object from any EasyList that 
displays that attribute.

Editing Object In EasyList
To edit an attribute from within an EasyList, simply double click in the cell which you want to 
edit and type the new attribute value and press return. For many attributes, you may use 
the EasyFill feature to enter the value partially and let EasyFill feature complete the value for
you. Refer to individual attributes help to see if EasyFill feature can be used for the given 
attribute.

Editing Object In EasyEditor
To edit an object within the EasyEditor, you need to first invoke the editor. You can invoke 
the EasyEditor in any of the following ways: 

1. From an EasyList by double clicking on the left most cell ( that displays the Id) of
the object you want to edit. This selects the object, and invokes the EasyEditor 
with the selected object ready for editing. 

2. From the Edit menu, by selecting the Editor menu item. 
3. By pressing the keyboard shortcut Ctrl-E. Press the "Ctrl" key and the "E" key 

simultaneously.
Next, you would need to select the object that you want to edit, if the object is already 
selected, you can skip this step. If not, then follow the steps on Selecting An Object to select 
an object.
Now, edit the desired attribute. See EasyEditor details on different ways to edit attributes.

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 
Group Object 



Jump To Object

You can jump to an object from EasyEditor and EasyLists. You can jump to object in one of 
the following ways:

1. Go the attribute that is displaying the object name that you want to jump to.
2. Press the keyboard shortcut Ctrl+J  Press Ctrl Key and J key simlutaneously. or
3. Select Jump To Object from the Edit menu.
Or

In EasyList, you can also right click in the cell where the object is being displayed as an 
attribute of an object. This will popup the context dependent menu. Choose the Jump To 
menu item.

EasyEditor
Within EasyEditor, you can jump to an object that is being referred to by an attribute of the 
currently displayed object. By jumping to the object also selects the object.
Example

If the EasyEditor is displaying a Person Joe. The name of his father is Bill. To display Bill, you 
can simply go to the father attribute, and then Jump To Bill by pressing Ctrl+J.
EasyList
Within EasyList, jump to implies scroll to object. You can scroll to an object that is being 
referred to by its name in one of the columns except for the first column.
Example

Lets say one of the columns of EasyList displays Living With attribute of Person objects. Each
row displays attributes of one object that is identified by its id in the Id column and by its 
name in column one. Lets say Joe is displayed in one of the rows and Joe is living with Sue. 
To scroll to Sue, go to the Living With attribute of Joe, and press Ctrl+J. The list will scroll to 
the row where Sue object is displayed in the list.

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 
Reminder Object 
Group Object 



Deleting An Object

To delete an object the object must first be selected. See Selecting An Object to select an 
object. You can delete a selected object by any of the following ways :

1. Select the Delete Object menu item from the Edit menu. 
2. Press the keyboard shortcut Ctrl+D. Press Ctrl Key and the "D" key 

simultaneously. 
3. Popup the context dependent menu by clicking the right mouse button in 

EasyList. Choose the Delete Object menu item.



Viewing An Object

You may view objects in many ways. You may:
· View (and Edit) In EasyList
· View (and Edit) In EasyEditor
· View In EasyLook

Viewing In EasyList:
There are times when you want to view only some of the attributes of a given type of 
objects. For example, you may want to view only the telephone numbers of all Business 
objects. The best place to view only specific attributes of all or some objects of one type is 
EasyList. 
EasyLists help you to view only the information that you want to. EasyManager comes with 
some predefined EasyLists. You may create new EasyLists, modify existing EasyLists or 
delete them altogether. See Customizing EasyList on how to create new or modify or delete 
existing EasyLists. 
Furthermore, you may filter objects to view withtin EasyList/EasyEditor by associating a 
filter with the EasyList. You can also view the objects in any order by associateing a sort 
(EasySort) criteria with the EasyList.

Viewing In EasyEditor:
EasyEditor is the best place to view all the attributes of one object. You may view any object 
of any type in EasyEditor, but only one object at a time. EasyEditor is also one of the 
windows to edit any attribute of the object you are viewing. 

Viewing In EasyLook:
If you want to look at some standard information quickly without having to search through 
the EasyLists or going through the EasyEditor, then EasyLook is the place. You cannot edit 
any of the attributes that you see, but it is very convenient place to lookup information like 
home address, telephone number, fax number and the like.

Viewing In EasyLabel:
EasyLabel is designed to display information as labels, by allowing you to format the way 
you want to present the information. There is nothing sacred about EasyLabels that you 
should use it only for making labels. You can view objects attributes in EasyLabels also. 
However, you cannot edit any of the attributes that you see. Apart from using EasyLabels for
printing labels, you can print Address books, save the address book in file, and view 
attributes the way you want to.

See Also
Person Object 



Business Object 
Account Object 
ToDo Object 
Reminder Object 
Group Object 



Filtering Objects

Objects are filtered using a filter criteria that you define. Once you have defined the filter 
criteria, you can use the filter criterias to filter objects that you want to view in EasyLists and
EasyLabels.
To Define Filter Criteria

1. Select Define Filter from the Edit menu. A dialog will be displayed showing all 
the currently defined filters. You can also get to this dialog from other dialogs 
like Edit EasyList Definition dialog, and Edit EasyLabel Definition dialog.

2. Click on Edit button to edit and redefine an existing filter, or New button to 
define a new filter criteria. An Edit EasyFilter Definition dialog will be 
displayed.

3. Define the filter criteria, and click on OK button.

To Apply Filter Criteria To EasyList
1. Open the Edit EasyList Definition dialog. You can do this by selecting the 

EasyList definition by either clicking on the Define EasyList from the 
EasyLists menu, or by clicking on Define... button on the EasyList itself.

2. Select one of the defined EasyFilter criteria to use with the EasyList. You can 
also define a new filter criteria by clicking on the Define EasyFilter button and 
following the steps above.

3. Click on OK button.
Or
1. Popup the context dependent popup menu by clicking anywhere within the 

EasyList. Choose the Filter By menu item, and then choose the desired filter 
object.

To Apply Filter Criteria To EasyLabel
1. Open the Edit EasyLabel Definition dialog. You can do this by selecting the 

EasyLabel definition by either clicking on the Define EasyLabel from the 
EasyLabels menu, or by clicking on Define... button on the EasyLabel itself.

2. Select one of the defined EasyFilter criteria to use with the EasyLabel. You can 
also define a new filter criteria by clicking on the Define EasyFilter button and 
following the steps above.

3. Click on OK button.

See Also
Person Object 
Business Object 
Account Object 
ToDo Object 



Reminder Object 
Group Object 



Sorting Objects

Objects are sorted using a sort criteria that you define. Once you have defined the sort 
criteria, you can use the sort criterias to sort objects in the order you want to view in 
EasyLists and EasyLabels.
To Define Sort Criteria

1. Select Define EasySort from the Edit menu. A dialog will be displayed showing
all the currently defined sort criterias. You can also get to this dialog from other 
dialogs like Edit EasyList Definition dialog, and Edit EasyLabel Definition 
dialog.

2. Click on Edit button to edit and redefine an existing sort criteria, or New button
to define a new sort criteria. An Edit EasySort Definition dialog will be 
displayed.

3. Define the sort criteria, and click on OK button.

To Apply Sort Criteria To EasyList
1. Open the Edit EasyList Definition dialog. You can do this by selecting the 

EasyList definition by either clicking on the Define EasyList from the 
EasyLists menu, or by clicking on Define... button on the EasyList itself.

2. Select one of the defined EasySort criteria to use with the EasyList. You can also 
define a new sort criteria by clicking on the Define EasySort button and 
following the steps above.

3. Click on OK button.
Or
1. Popup the context dependent popup menu by clicking anywhere within the 

EasyList. Choose the Sort By menu item, and then choose the desired sort 
object.

To Apply Sort Criteria To EasyLabel
1. Open the Edit EasyLabel Definition dialog. You can do this by selecting the 

EasyLabel definition by either clicking on the Define EasyLabel from the 
EasyLabels menu, or by clicking on Define... button on the EasyLabel itself.

2. Select one of the defined EasySort criteria to use with the EasyLabel. You can 
also define a new sort criteria by clicking on the Define EasySort button and 
following the steps above.

3. Click on OK button.

See Also
Person Object 
Business Object 
Account Object 
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EasyList: Adding Multi-valued Attribute Values

EasyManager allows having unlimited number of phone/fax numbers, email addresses, and 
so on. Objects attributes can further refer to more than one object. For example, Belongs 
To Groups attribute of Person and other objects can refer to more than one group object.
In EasyLists, you can enter a value of any given attribute by simply going to the appropriate 
cell, and typing the value into the cell. For attributes that can have multiple values like 
phone numbers, you can enter multiple values as follows:

1. Go to the appropriate cell where you want to add another value. If the cell is 
empty, then type the value in.

2. If the cell is not empty, press the right mouse button while keeping the mouse 
pointer in the cell where you want to add another value. A context dependent 
popup menu is displayed. The menu contains the menu items Add: <Col 
Title>.. Choose this menu item.

3. An empty row will be added at the end of the row in which the object is 
displayed in the EasyList. For example, if an object X uses rows 2 to 5, a new 
row will be added after row 5. You can now type in the appropriate value.



EasyList: Removing Multi-valued Attribute Values

EasyManager allows having unlimited number of phone/fax numbers, email addresses, and 
so on. Objects attributes can further refer to more than one object. For example, Belongs 
To Groups attribute of Person and other objects can refer to more than one group object.
In EasyLists, you can remove a value of the set of values tha any given attribute as follows:

1. Go to the appropriate cell where you want to remove an existing value.
2. If the cell is not empty, press the right mouse button while keeping the mouse 

pointer in the cell where you want to remove an existing value. A context 
dependent popup menu is displayed. The menu contains the menu items 
Remove: <Col Title>.. Choose this menu item.

3. The value is removed.



Dialing Phone Numbers

To dial a phone number associated with any attribute of a given object, follow the steps 
below.

1. Currently you can only dial by using the right button popup menu from within 
EasyList and EasyLook. So open an EasyList, or find the object in EasyLook.

2. Goto the row where the desired object is displayed. Click the right mouse 
button. A context dependent menu will be displayed.

3. Goto the Dial sub-menu. A submenu will be displayed with a list of all the phone
numbers associated with the given object.

4. Choose a phone number from the submenu. The number is dialed for you if you 
have a modem and the dialer support.



Sending Email

To send an electronic mail to an address associated with any attribute of a given object, 
follow the steps below.

1. Currently you can only send email by using the right button popup menu from 
within EasyList and EasyLook. So open an EasyList, or find the object in 
EasyLook.

2. Goto the row where the desired object is displayed. Click the right mouse 
button. A context dependent menu will be displayed.

3. Goto the Email submenu. A submenu will be displayed with a list of all 
electronic mail address associated with the given object.

4. Choose an electronic mail address from the submenu. The electronic mail 
program is invoked and the To is set to the email address of the person.
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Getting Started

The first important information is to remember that you can get help by simply pressing F1 
Key from anywhere in the program. You can also obtain context-sensitive help by pressing 
Shift+F1 Key at anytime.
After you have successfully installed EasyManager, read the following topics first.

Readme.txt file for the latest information and general advice on using 
EasyManager.
Features for the features of EasyManager.
Overview for an overview of EasyManager.
Objects for an introduction to the concept of objects.

After that, the first thing you would do is open a new document. Select New... menu item 
from the File menu to create a new document. You may also open an existing document if 
you have any, by selecting the Open... menu item from the File menu.
Open the EasyEditor by selecting the EasyEditor... menu item from the Edit menu or by 
pressing the Ctrl+E key, or by clicking on the  in the toolbar.
Now you are ready to create/edit/delete objects. See help on the following topics:

Create An Object for steps on how to create objects
Edit An Object for steps on how to edit objects.
Delete An Object for steps on how to delete objects.
Select An Object for steps on how to select an object.
View An Object for steps on how to view objects.

After creating a few objects, open a pre-defined EasyList. Select any EasyList that interests 
you by selecting the appropriate menu item from the EasyLists menu. You can view, create,
edit, and delete objects from any EasyList also. See the topics above for help.
You can save the file with all the changes by selecting the Save... menu item from the File 
menu. You will be prompted for a file name if you opened a new file.
By now, you can open a file, create, edit and delete objects, view objects and save the file.

The next step, is to learn to create or modify the pre-existing EasyList(s) to meet your needs.
Select the Define EasyLists... menu item from EasyLists menu. See help on following 
topics for details:

Create A New EasyList for steps on how to create a new EasyList.
Edit An Existing EasyList Definition for steps on how to edit an existing EasyList.
Delete An Existing EasyList for steps on how to delete an existing EasyList.

For other advanced topics, ask for help under the appropriate index in the Table Of Contents.



Getting Help

When running EasyManager, help is always at hand whenever you need it. You can ask for 
help in any of the following ways:
At any time in the program, Press F1 Key. This brings up the help window with the help for 
the last active window. It could be a message box, EasyEditor, EasyList, or anything else.
You can get context sensitive help for menu commands and toolbars by pressing Shift-F1, 
and then clicking on the menu item, or the toolbar button.
You can go to the top level help by selecting the Help Index menu item from the Help menu.



Overview Of EasyExport

One of the advantage of using EasyManager is to help you manage information at one 
common place, and then allow you to easily export the Object to other applications.
When you export the desired objects to other programs the following points are worth 
knowing:

· Only the data relevant to that application is exported.
· All data that is exported is uniquely identified by the name of the object.
· EasyExport never deletes the old information that was not exported before by 

EasyManager.
· While exporting, if a record/object already exists in the application database but

does not exist in the EasyManager database (identified by name), than that 
record is untouched during the export. 
The only time the record will be deleted from the application database is if (1) 
the record was previously exported by EasyManager, (2) the object has not 
been chosen to be exported or has since been deleted from EasyManager 
database, and (3) you have explicitly asked to delete previously exported data 
by checking the check box in the export dialog box.

· If a record/object exists both in the application database and in the 
EasyManager database (identified by name), than that record is updated with 
the relevant data that exists in EasyManager database.

· If a record/object does not exists in the application database, but exists in the 
EasyManager database (identified by name), than a new record is created in the
application database and the relevant data exported from EasyManager 
database.

Currently, you can export relevant data of the desired objects to following applications.
· CompuServe Information Manager Address Book (Versions 1.x and 2.x)
· EasyList Data To Comma/Tab Separated Text File that can then be exported to 

other Spreadsheet, Database and many other applications that read comma/tab
separated data.

This is an area where support for more applications are being developed. Make sure you 
have registered EasyManager so that you get new updates with support for exporting data 
to more applications. See Registering EasyManager on how to register.
If you have a favorite application that you would like to export data to, let us know. See 
Feedback on how to contact us.
For step by step instructions on exporting objects of your choice, see Exporting Objects.



EasyExport - Exporting Objects

To export relevant attributes of objects to other programs you invoke the EasyExport in one 
of the following ways:

1. Select the EasyExport menu item from the File menu.
2. Press Keyboard shortcut Ctrl + X - Press X key while holding down the Ctrl key.

This will invoke the EasyExport Dialog. Follow the steps below to export the objects:
1. Select the objects you want to export. You can choose to export all objects of 

one or more types in the database, or all objects that you can view in any of the
open EasyLists, or any combination of these.

2. Select the target application/destination where you want the relevant attributes 
of the objects to be exported by selecting one of the items in the Target list 
box. The contents of the list box displays only the relevant targets to which you 
can export depending on the objects that you have chosen to export.

3. Select the data that you want to export from the Data To Export list box. The 
contents of the list box displays only the data that you can export, relevant to 
the target that you have chosen.

4. Modify the export file name if necessary to specify the file where the data 
should be exported into.

5. Check the Delete Previously Exported Data check button if you want to 
delete the data that you had exported before (if any). This should generally be 
checked if you are exporting all the objects in the database.

6. Click OK.

Also See
EasyExport
EasyExport Dialog



EasyExport Dialog

This dialog allows you export the desired data of desired objects to the desired target.

Objects To Export
All Person Objects: Check this box to export the relevant data of all the Person objects in 
the database.
All Business Objects: Check this box to export the relevant data of all the Business 
objects in the database.
All Group Objects: Check this box to export the relevant data of all the Group objects in 
the database.
Objects In List: Check this box and select a EasyList to export the objects that you view in 
the chosen EasyList.

Export Target
DosCIM 1.x or DosCIM 2.1.x: Select this target to export the relevant data to CompuServe
Information Manager Address Book for DosCIM versions 1.x or 2.1.x.
DosCIM 2.2.x or WinCIM 2.x: Select this target to export the relevant data to CompuServe
Information Manager Address Book for DosCIM version 2.2.x or WinCIM 2.x.
Tab Separated Text File: Select this target to export all the data in the selected EasyList 
as a tab separated text (ASCII) file. This data can then be read by many spreadsheets, 
databases and word processor programs. This option is available only if you select the 
Objects In List option in the Objects To Export section.
Comma Separated Text File: Select this target to export all the data in the selected 
EasyList as a comma separated text (ASCII) file. This data can then be read by many 
spreadsheets, databases and word processor programs. This option is available only if you 
select the Objects In List option in the Objects To Export section.

Data To Export
Email Address: Select this choice to export the electronic mail addresses of the desired 
objects to the desired target. This choice is available only if it is relevant for the selected 
target.
Fax Numbers: Select this choice to export fax numbers of the desired objects to the desired
target. This choice is available only if it is relevant for the selected target.
Telephone Numbers: Select this choice to export telephone numbers of the desired objects
to the desired target. The choice is available only if is relevant for the selected target.
Postal Address: Select this choice to export postal address of the desired objects to the 
desired target. The choice is available only if is relevant for the selected target.
Email Address And Fax Number: Select this choice to export electronic mail address and 
fax numbers of the desired objects to the desired target. The choice is available only if it is 
relevant for the selected target.



List Data: Select this choice to export the EasyList data to the desired target. The choice is 
available only if its relevant for the selected target.

Delete Previously Exported Data
Select this option to delete any information that was previously exported from EasyManager.
EasyManager puts a tag wherever possible for all information that it exports. This way if an 
object or the data is deleted, that data is also deleted from the target when exporting the 
current information.

Export To File
Specify the file name with full path or relative path from the current working directory. When 
you choose a target, the default file name is filled.

Browse Button
Click on this button to browse the file directory on the disk to choose a file name where to 
export.

Export Button
Click this button to export the relevant information from the selected objects.

Cancel Button
Click on this button if you want to cancel the export process.

See Also
Exporting Objects



EasyImport - Importing Data

EasyImport imports data from text files and from other applications. Currently, it supports 
importing from the following sources:

· Character Separated Text files
· CompuServe Information Manager Address Book

In future, more sources will be supported for import. If you have a favorite program, and 
would like to import information directly from that application, please let us know. Go to 
feedback on how to contact us.
Follow the steps below to import data:

1. Select the EasyImport menu item from the File menu, or Press keyboard 
shortcut Ctrl + I. This will invoke the EasyImport Dialog.

2. Select one of the sources from the list of possible import sources either by 
clicking on the desired source, and pressing Import button, or by double 
clicking on the desired source.

3. This will display the appropriate dialog box. You can change the default values in
the dialog box to customize the import behavior. Press Import button to import 
relevant data from the chosen source.

Also See
Importing From Text File
Import Text File Dialog
Import CompuServe Address Book Dialog



Importing From Text File

EasyImport can import any data that you desire from character (comma, tab, semicolon, 
etc.) separated text files. Each record represents an Object within EasyManager. Records in 
the text file should be separated by new line, while fields or attributes should be separated 
by a single character specified in the dialog box. The first field in the record should be the 
name attribute of the object. If a field value is empty for any record, the particular field 
value is not modified while importing.
Follow the steps below to import data:

1. Create or modify an existing EasyList such that each of the columns in the 
EasyList represents a field in the text file. If you want to ignore a field, define 
the corresponding column as empty column.

2. Select the EasyImport menu item from the File menu, or Press keyboard 
shortcut Ctrl + I. This will invoke the EasyImport Dialog.

3. Select Character Separated Text File as the import source by either doubling
clicking on the import source, or by clicking on the import source once, and 
pressing Import button. This will display the dialog box for importing from 
Character separated text file. Enter/change the default values, and press 
Import. This will import the data from the specified text file.

Also See
Import Text File Dialog
EasyImport - Importing Data



Import Text File Dialog

The following options allow you to specify what data to import:

Import From File
Enter the name of the file (data source) from which the data is to be imported. You may 
use the Browse button to browse the files.

EasyList That Represents Column Format
Select an EasyList whose column definition matches the column definition of the text file 
from which data is to be imported.

Has Row Headers
Check this box if the first field of each record represents the record header. For example, 
the first record could represent a record Id. Checking this box simply ignores the first 
column of every record.

Has Column Headers
Check this box if the first record in the text file represents the column (field) headers. 
Checking this box simply ignores the first record.

Column Delimiter
Select or enter a column delimiter. A column delimiter is a one character separator that 
is used to separate column (field) entries.

Append To Existing Data
This option affect only attributes that can have multiple values. Check this box if the 
previous attribute values of a multiple-valued attribute should not be deleted before 
importing data. For example, a Person object can have multiple home telephone 
numbers. If you were importing home telephone numbers, the numbers being imported 
can be added to the list of existing telephone numbers for a given Person, or the existing
numbers can first be deleted before importing a telephone number for a given Person. 
Checking this box will not delete the existing numbers before importing.

Also See
Importing From Text File
EasyImport - Importing Data



Import CompuServe (CIM) Address Book Dialog

The following options allow you to specify what data to import:

Import From Address Book [File]
Enter the name of the file (data source) from which the data is to be imported. You may 
use the Browse button to browse the files.
Normally, it is C:\CSERVE\support\addrbook.dat for WinCIM and for DosCIM versions 
2.2.x. For DosCIM versions 1.x and 2.1.x, the path is C:\CSERVE\addrbook.dat. If CIM is 
installed in a directory other than C:\CSERVE, then replace C:\CSERVE with the directory 
where CIM is installed.

Type of object to create If Name does not exist
Select the type of object to create for names that do not exist in the database. This 
information is used only for non-group records. Group objects are created for group 
records.
When importing from the address book, EasyManager attempts to find an existing Object
by the name of the record that is being imported from the address book. If it cannot find 
a Person or a Business object by name, it will create a new object. You can decide what 
type of object to create in such cases.

Do not import previously exported records
Check this box if you do not want re-import records that were previously exported from 
EasyManager. A record exported by EasyManager is identified by the {{EasyManager 
Exported Data}} string as the comments for that record.

Append To Existing Addresses
Check this box if you want to append the addresses being imported to the existing 
electronic mail addresses/fax numbers for the objects being imported. Uncheck this box 
if you want to delete the existing addresses before importing addresses for the objects 
being imported.
While importing addresses, even if this box is checked, it will not create duplicate 
address if the address already exists for the object being imported.

Also See
EasyImport - Importing Data



EasyLabel Window Layout

EasyLabel window displays the labels by evaluating the label format specification. Labels are
displayed the way they will be printed. If the label format is defined as simple or advanced 
format, one label is displayed for each object of the specified type.
EasyLabels can also be used to print Address Books, and other books that represent the data
of your choice. Define the label format specification appropriately using the Define 
EasyLabel... menu item from EasyLabel menu.
EasyLabels can also be used to print from address labels. Use the fixed label format and 
enter your address as the label specification.
You can modify the contents of the label (after label format specification has been 
evaluated) before printing or exporting by editing the label data directly.
You can also change the label width, height, and horizontal and vertical spacing between 
labels by dragging the edge of the label in the row or column headers. Changing the size in 
this way does not save the page setup for the label for later use.

Buttons

Export...
Press this button to export the label data to a text file. Note that labels are always 
exported as one column even if the labels are displayed in more than one column.

Print...
Press this button to print the labels on plain paper or on label forms.

Page Setup...
Press this button to change the page setup for the labels. This invokes the EasyLabel 
Page Setup Dialog.

Update
Press this button to refresh the labels. This is useful if you modify objects after 
opening the EasyLabel window, and you need to update the labels.

Define...
Press this button to edit the definition of the EasyLabel.

Close
Press this button to close the label window.

See Also
EasyLabel Page Setup Dialog
EasyLabel Editor
Define EasyLabel...



EasyLabel Editor

EasyLabel Editor presents the following options to define labels:

EasyLabel Name
Specify the name of the EasyLabel. This is the name that will appear under the EasyLabel
menu. The name should not be the same as another EasyLabel name.

EasyLabel Format
Select a format for the contents of the EasyLabel.
Fixed Format: Select fixed format to create an label with no variables. This format is 
useful for printing your own from address labels. You must also specify the Number of 
Labels that you want to print.
Simple Format: Select this format if you want to define a label with embedded object 
attributes. You must also select the Type of object for which you want to define the label.
Advanced Format: Select this format if you want to define a label with embedded 
object attributes. This format requires the understanding of the internal data model, and 
hence is not advised for users. You must also select the Type of object for which you 
want to define the label.

Type
Specify the type of objects for which this label is being defined. You must select a type if 
you are defining a simple or advanced format labels.

Use EasyFilter
Specify the EasyFilter criteria to use. If a filter criteria is specified, then only the objects 
that satisfy the criteria will be displayed in the Easylabel. Otherwise, all objects will be 
displayed.

Use EasySort
Specify the EasySort criteria to use. If a sort criteria is specified, then the objects will be 
sorted and displayed in the specified order. Otherwise, the objects will be displayed in no
particular order.

EasyLabel Format Specification
Specify the label definition. The label can contain normal text, and attribute variables. To 
insert a attribute variable, position the cursor where you want to insert the variable, and 
then double click the desired variable from the Attribute Choices List. The variable will
appear within enclosed angle parenthesis.

Number of Labels (fixed format)
Specify the number of labels to print for fixed format labels. For simple and advanced 
format labels, the number of labels is determined by the number of objects of the chosen
type.

Attribute Choice List
This presents a list of all possible attributes for a given Type of objects. You can insert an
attribute in the label format specification by simply double clicking any of the attribute 
choice.

Define Filter...
Click this button to invoke the EasyFilter Editor to define a new Filter criteria, or to edit an
existing filter criteria.



Define Sort...
Click this button to invoke the EasySort Editor to define a new Sort criteria, or to edit an 
existing Sort criteria.

Page Setup...
Click this button to display EasyLabel Page Setup Dialog. Use the page setup dialog to 
specify the page layout for printing labels 

OK
Click this button to save the EasyLabel definition and close the EasyLabel Editor.

Cancel
Click this button to ignore any modifications made to EasyLabel definition and close the 
EasyLabel Editor.

See Also
EasyLabel Page Setup Dialog
EasyFilter Editor
EasySort Editor



EasyLabel - Page Setup Dialog

The following options allow you to specify the page setup for printing labels:

Label Style
Select a pre-defined label style if one exists, or select custom style.

Paper Size
Specify the width and height of the paper in inches.

Margins
Specify the left, right, top and bottom margins in inches.

Column Parameters - Width
Check the Max Fit box if you want the program to determine the maximum label width 
that will fit all the text or else specify a fixed label width in inches

Column Parameters - Number of columns
Specify number of columns i.e. number of labels to be printed across on a page.

Column Parameters - Space between columns
Specify the space between columns in inches if the number of columns is more than one.

Row Parameters - Height
Check the Max Fit box if you want the program to determine the maximum label height 
that will fit all the text or else specify a fixed label height in inches

Row Parameters - Space between rows
Specify the space between label rows in inches.

See Also
EasyLabel Editor



EasyFilter Editor

EasyFilter Editor presents the following options to define filter criteria:

EasyFilter Name
Specify the name of the EasyFilter. This is the name that will be used to refer to the filter 
criteria you define. It will appear in the Use EasyFilter drop-down box in EasyList Editor 
and EasyLabel Editors and other places as necessary. The name should not be the same 
as another EasyFilter name.

Type
Specify the type of objects for which this filter is being defined. You must select a type 
before defining the filter criteria.

Ignore Case
Check this button if you want to ignore case when comparing string values. Uncheck this 
button if you want to take case into consideration when comparing string values.

Filter Criteria
This is where you define the filter criteria. You can define as many criteria you want to, 
and AND/OR them together. You can also use parenthesis to club expressions together.
( Column: In this column you enter the open parenthesis if you need to enclose 
expressions within parenthesis. You can enter multiple open parenthesis if you need to.
Attribute Column: In this column you enter the attribute name you want to use to 
evaluate if the object meets the filter criteria. The valid attributes are displayed in the 
Choice List. You can simply single click on the choice, and it will be entered in the 
attribute column. Note that the choices presented are sufficient for most filter needs. You
can specify more combinations. See help on filter expression for more details.
Operator Column: In this column you enter what kind of comparison you want to do. 
The valid choices are displayed in the Choice List. You can simply single click on the 
choice, and it will be entered in the operator column.
Value Column: In this column you enter the value you are comparing against the value 
of the attributes. You specify the value depending on the type of the attribute. For certain
attributes the valid choices are also displayed in the Choice List. One of the common 
choices is EMPTY which means compare if the value is empty.

Choice List
This provides a list of valid choices for the given cell that is currently active in the Filter 
Criteria. You can simply select the choice you want to enter by clicking on the item in 
this list, and the item will be entered into the currently active filter criteria cell.

Insert Row After
To insert a new row after a given row, click on the row after which you want to insert a 
new row. Press the Insert Row After button. A new row will be inserted just after the 
current row.

Insert Row Before
To insert a new row before a given row, click on the row before which a new row is to be 
inserted. Press the Insert Row Before button. A new row will be inserted before the 
current row.

Delete Row



To delete a given row, simply click on the row you want to delete, and then press the 
Delete Row button. The row will be deleted.

Revert
Click this button to restore the previously saved definition of the EasyFilter. The current 
modifications will be lost.

Clear
Click this button to clear the filter criteria, and start over.

OK
Click this button to save the EasyFilter definition and close the EasyFilter Editor.

Cancel
Click this button to ignore any modifications made to EasyFilter definition and close the 
EasyFilter Editor.

See Also
Overview Of EasyFilter
EasyFilter Expression



EasySort Editor

EasySort Editor presents the following options to define sort criteria:

EasySort Name
Specify the name of the EasySort. This is the name that will be used to refer to the sort 
criteria you define. It will appear in the Use EasySort drop-down box in EasyList Editor 
and EasyLabel Editors and other places as necessary. The name should not be the same 
as another EasySort name.

Type
Specify the type of objects for which this sort is being defined. You must select a type 
before defining the sort criteria.

Descending
Check this button if you want to sort in descending order. Uncheck this button if you 
want to sort in ascending order.

Ignore Case
Check this button if you want to ignore case when comparing string values. Uncheck this 
button if you want to take case into consideration when comparing string values.

Sort Keys
This is where you define the sort keys, i.e. keys to use to sort objects. You can define as 
many sort keys as you want. The first key is the primary key, the rest are secondary 
keys.
Attribute Column: In this column you enter the attribute name you want to use to sort 
the objects. The valid attributes are displayed in the Choice List. You can simply single 
click on the choice, and it will be entered in the attribute column. Note that the choices 
presented are sufficient for most sorting needs. You can specify more combinations. See 
help on filter expression for more details.

Choice List
This provides a list of valid choices for the given cell that is currently active in the Sort 
Keys. You can simply select the choice you want to enter by clicking on the item in this 
list, and the item will be entered into the currently active sort keys cell.

Insert Row After
To insert a new row after a given row, click on the row after which you want to insert a 
new row. Press the Insert Row After button. A new row will be inserted just after the 
current row.

Insert Row Before
To insert a new row before a given row, click on the row before which a new row is to be 
inserted. Press the Insert Row Before button. A new row will be inserted before the 
current row.

Delete Row
To delete a given row, simply click on the row you want to delete, and then press the 
Delete Row button. The row will be deleted.

Revert
Click this button to restore the previously saved definition of the EasySort. The current 
modifications will be lost.



Clear
Click this button to clear the sort keys, and start over.

OK
Click this button to save the EasySort definition and close the EasySort Editor.

Cancel
Click this button to ignore any modifications made to EasySort definition and close the 
EasySort Editor.

See Also
Overview Of EasySort
EasyFilter Expression



Editing Date Attribute

Any attribute that represents a date, can be edited as follows:
1. Double click in the cell you want to edit.
2. Press F2 to clear the date value.
3. Press F3 to enter today's date.
4. Press F4 to pop-up a calendar to choose a date.
5. Use the spin buttons to increment or decrement the date values.
6. Type in the date in the current date format. This is the same format as the 

Windows settings. The date separators appear automatically as you type each 
component of date.

NOTE:
Make sure you enter year with the century, i.e. year 1996 is correct but just 96 
is not correct. This is to avoid the confusion when we get to the next century.
Valid values for month are 01 to 12
Valid values for day are 01 to 31
Valid values for year are 1800 to 2100



Overview Of EasyFill

EasyFill feature boosts your productivity by completing partially filled values for many of the 
attributes of Objects. When editing an attribute that supports EasyFill feature, simply type in 
a few characters and press return. EasyFill feature will takes the following action:

· If you typed in enough number of characters to uniquely identify the value to 
complete, it will do so.

· If the number of characters you typed in, matches more than one possible 
values that could be used for completion, a selection box will be displayed with 
the set of possible value choices that match the characters that you typed in.

· If the number of characters you typed in does not match any of the possible 
values that could be used for completion, a selection box will be displayed with 
all the possible value choices 

· You then make a selection of the value you want by double clicking on one of 
the items in the selection box, or by clicking once to select the item and 
pressing OK.

To find out if a given attribute supports the EasyFill feature, see the help on the individual 
attribute.
In general, all attributes that refer to other objects like Person, Business and Groups support 
the EasyFill feature. Also, if there was only a pre-defined and discrete set of choices that can 
be entered for a particular attribute, than that attribute also supports the EasyFill feature. An
example of such an attribute is Sex in Person Object.



Overview Of EasyList

EasyList is a powerful way to view and edit the desired attributes of a specific type of object.
An EasyList specifies a set of attributes in a particular order that is convenient to you. For 
example, you may want to define a EasyList to view and/or edit person home telephone 
numbers only and not have to worry about other attributes or Person Object.
EasyLists provide a consistent view of the Objects across all EasyLists and all other ways 
that you view the Objects. See Viewing An Object on different ways to view any Object.
You use EasyLists for the following activities:

1. Create an object. See Creating An Object on how to create objects in a 
EasyList.

2. Delete an object. See Deleting An Object on how to delete objects using 
EasyLists.

3. Modify attributes of the objects that you view. See Editing An Object on how to 
modify objects in a EasyList.

4. Select an object. See Selecting An Object on how to select an object that you 
see in a EasyList.

5. Define filter criteria on what objects you want to view. See Filtering Objects on 
how to define filters so that you only view objects that meet the filter criteria.

6. Export only the objects that you view (filtered by the filter criteria). See 
Exporting Objects on how to export objects in a EasyList.

EasyManager comes with a set of pre-defined EasyLists that you can access from the 
EasyList menu as mentioned below.

Person Home Address List
Display and edit home address of Person objects 

Person Work Address List
Display and edit work address of Person objects

Person Telephone List
Display and edit home and work phone number of Person objects

Person Email List
Display and edit electronic mail addresses of Person objects

Person Birthday/Anniversary List
Display and edit birthday and anniversary dates of Person objects

Family Relations
Display and edit parent and spouse relationship between Person objects

Business Address List
Display and edit postal address of Business objects

Account List
Display and edit account details and telephone numbers of Account objects



ToDo List
Display and edit ToDo objects

Reminder List
Display and edit reminder objects

You can create your own EasyLists and add them to or remove them from the EasyList 
menu using the Define EasyList command. 

See Also
EasyList Layout
Customizing EasyList 
Overview of EasyEditor 
Overview of EasyLook 

Overview of Objects 
Creating An Object 
Editing An Object 
Deleting An Object 
Viewing An Object 
Filtering Objects 
Sorting Objects 
Selecting An Object 



EasyList Layout

The EasyList window displays the desired attributes of the objects of a given type as lists.
The name of the EasyList is displayed as the title of the window. The title will also display a 
number if more than one EasyList window with the same title is open. A new EasyList with 
the same title can be opened by clicking on the New menu command from the Window 
menu.
The list of objects and their desired attributes are displayed as follows:

· Each row starts with a row header. Row headers display the Id of the object 
being displayed in that row.

· Each column starts with the column header. Each column header displays the 
column title. The title can be customized by you. Each column displays the 
value of the attribute of the object that is identified by the object Id in the row 
header.

· The first column always displays the name of the object.
· The rest of the columns display the desired attributes of the object. Each 

column displays only one attribute of the object.

You can perform the following actions on the list:

Scroll
Use the scroll keys to scroll the list.

Edit Attribute
To edit an attribute, double click in the cell you want to edit. You will enter the edit mode.
Modify the value and press return or press one of the arrow or tab keys to end edit mode.
The attribute value is automatically updated in all other EasyLists and EasyEditor where 
the attribute is displayed.
To cancel the edit mode, press Esc.

Select Object
You can select an object by clicking on the object Id cell which is displayed in the row 
header. The selected object appears in reverse video.

Deselect Object
Click anywhere in the list except the row header, and the selected object (if any) will be 
deselected.

Delete Object
Select the object that you want to delete, and press Ctrl+D, or select the Delete Object 
command from the Edit menu.

Create New Object
Go to the first column of the last row. Enter the name of the object you want to create. 
The object is automatically created, and is displayed in all the open EasyLists.

Invoke EasyEditor
Double click on the object Id of the object you want to edit. EasyEditor will be displayed.



Jump/Scroll To Object
Go to the cell in which the object is being displayed. Press Ctrl+J. The EasyList will be 
scrolled to the object that is being referred to in the cell.

Invoke Context Dependent Right Button Popup Menu
Go to the cell for which you want to popup the context dependent menu. Click on the 
right mouse button. A context dependent menu will be displayed. This has menu items to
do things quickly - like selecting, deselecting, adding/removing one value of a multi-
valued attribute (like phone numbers), dialing and sending electronic mails.

Dial/Email
To dial a phone number of a given object (like home number of Person object) or to send 
an electronic mail, simply click the right button in any cell of the row which displays the 
object. A context dependent menu will be displayed. Choose Dial or EMail menu item, 
and select the number to dial or electronic mail address to send mail.

Buttons

Editor...
Press this button to invoke the EasyEditor.

Update
Press this button to re-filter and resort the EasyList. Normally, when creating and 
modifying the objects, the objects are not automatically filtered or sorted. To filter and 
sort the objects, press this button.

Find...
 Press this button to find an object by name within the EasyList.

Define...
Press this button to edit the definition of the EasyList.

Close
Press this button to close the EasyList.

See Also
Overview of EasyList
Customizing EasyList
Overview of EasyEditor
Overview of EasyFilter
Overview of EasyLook



Customizing EasyList

You can do the following basic operations in order to define and customize EasyLists.
1. Create a new EasyList
2. Modify the definition of an existing EasyList
3. Delete an existing EasyList
4. Choose a font in which to display all EasyLists

Creating a New EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Click on the New button to define a new EasyList. The EasyList Editor will be 

displayed.
3. Define the title, the object type, and the columns.
4. Press OK.

Modifying Definition of An Existing EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Select the EasyList which you want to modify and press the Edit button. or 

double-click on the EasyList. The EasyList Editor will be displayed with the 
existing definition of the selected EasyList.

3. Modify the EasyList as desired.
4. Press OK. The EasyList definition will be updated and the EasyList Editor 

dialog will be closed.
5. Press Close.

You can also invoke the EasyList Editor of an open EasyList by clicking on the Define... 
button.

Deleting An Existing EasyList
1. Select the Define EasyList menu item from the EasyLists menu. Define 

EasyList dialog will be displayed.
2. Select the EasyList which you want to delete and press the Delete button. The 

EasyList will be deleted.
3. Press Close.

Selecting EasyList Font



1. Select the EasyList Font menu item from the EasyLists menu. EasyList Font 
dialog will be displayed.

2. Choose the desired font, and press OK.
3. All the EasyLists will be updated to use the chosen font.

See Also
Overview of EasyList
EasyList Editor
EasyList Layout
Printing EasyList



EasyList Editor

EasyList editor is used to define a new EasyList or to modify the definition of an existing 
EasyList. An EasyList is fully defined when the following components are defined:

EasyList Name
Specify the (unique) name of the EasyList. This is the name that will appear under the 
EasyList menu. The name should not be the same as another EasyList name.

Type
The type of object that is to be displayed in the EasyList. Only one type of object can be 
displayed in a given EasyList.

Use EasyFilter
Specify the EasyFilter criteria to use. If a filter criteria is specified, then only the objects 
that satisfy the criteria will be displayed in the EasyList. Otherwise, all objects will be 
displayed.

Use EasySort
Specify the EasySort criteria to use. If a sort criteria is specified, then the objects will be 
sorted and displayed in the specified order. Otherwise, the objects will be displayed in no
particular order.

Columns
You must define all the columns of an EasyList. A column is defined by specifying the 
attribute to display in the given column, the column title, and the column width. The
list of attributes that can be displayed depends on the type of object.
Column Attribute: Select the attribute to display by selecting one of the item in the 
combo-box for the column.
Column Title: Specify the title of the column that should appear at the top of the column. 
By default it is the same as the name of the attribute.
Column Width: Specify the width of the column by dragging the anchor at the top right of
the desired column. You may also change the width of the column later from the EasyList
directly.

Insert Column After
To insert a new column after a given column, select the column after which you want to 
insert a new column. Press the Insert Column After button. A new column will be 
inserted just after the current column.

Insert Column Before
To insert a new column before a given column, select the column before which a new 
column is to be inserted. Press the Insert Column Before button. A new column will be 
inserted before the current column.

Delete Column
To delete a given column, simply select the column by clicking anywhere in the column, 
and then press the Delete Column button. The column will be deleted.

Define Filter...
Click this button to invoke the EasyFilter Editor to define a new Filter criteria, or to edit an
existing filter criteria.



Define Sort...
Click this button to invoke the EasySort Editor to define a new Sort criteria, or to edit an 
existing Sort criteria.

OK
Click this button to save the EasyList definition and close the EasyList Editor.

Cancel
Click this button to ignore any modifications made to EasyList definition and close the 
EasyList Editor.

See Also
Overview of EasyList
Customizing EasyList
EasyFilter Editor
EasySort Editor



Printing EasyList

EasyLists can be printed on any Windows compatible printer. The EasyList is printed exactly 
the way you see on the screen. If you want to hide a particular column, simply resize the 
column to zero width. You may customize the printing by selecting or deselecting the print 
options in the EasyList Print Dialog.

To print an EasyList, follow the steps below:
1. Open the EasyList that you want to print by selecting the desired EasyList menu

item from the EasyLists menu.
2. Select the Print EasyList menu item from the File menu or the Print EasyList

button on the toolbar or press the Ctrl+P keyboard shortcut. The Print EasyList 
dialog will be displayed
Or 
Right click the mouse button within the EasyList. A context dependent menu will
be displayed. Choose the Print EasyList... menu item. The Print EasyList dialog
will be displayed.

3. Customize by choosing the desired print options.
4. Press OK.

See Also
EasyList Print Dialog
Overview of EasyList
EasyList Editor



EasyList Print Dialog

The Print dialog is used to customize EasyList printing. Following options can be customized:
Header The text to print at the top of each page. Click on Header to view 

details on customizing it.
Footer The text to print at the bottom of each page. Click on Footer to view 

details on customizing it.
Margins Specify the size of top, bottom, left, and right margins in inches.
Grid Select to print grid.
Border Select to print border around the EasyList.
Color Select to print colors, deselect to print in gray scale.
Column Headers Select to print column headers, deselect to not print column 

headers
Row Headers Select to print row headers (object ids), deselect to not print row 

headers.
Header Shadows Select to print a shadow effect on column and row headers. This

option has no effect if both Column Headers and Row Headers are 
deselected.

All Pages Select to print all the pages of the EasyList. The From and To are 
ignored if this option is selected.

From Enter the first page to print if All Pages is not selected.
To Enter the last page to print if All Pages is not selected.
Smart Print Select to fit the EasyList on the page as best as possible. Click on 

Smart Print to view rules that are used to print if this option is selected.

See Also
Printing EasyList



EasyList Print Dialog: Header/Footer

Specifies the text to be printed as the header at the top of each page, and as the footer at 
the bottom of each page.

The default header prints the Title of EasyList and the default footer prints the page number.
You can however, customize the textual contents as well as the format of header/footer the 
way you want to. Following control characters are available to format the header/footer.

Escape code Description

/n New line
/l Left justify text
/r Right justify text
/c Center text
/p Insert page number
// Print '/'
/fn Font name followed must be enclosed in quotes "".
/fz Font size must be enclosed in quotes "".
/fb0 Font bold off.
/fb1 Font bold on.
/fi0 Font italics off.
/fi1 Font italics on.
/fu0 Font underline off.
/fu1 Font underline on.
/fk0 Font Strike through off.
/fk1 Font Strike through on.
/fs1 Save the current font configuration as configuration 1.
/fs2 Save the current font configuration as configuration 2.
/fs3 Save the current font configuration as configuration 3.
/fs4 Save the current font configuration as configuration 4.
/fs5 Save the current font configuration as configuration 5.
/fs6 Save the current font configuration as configuration 6.
/fs7 Save the current font configuration as configuration 7.
/fs8 Save the current font configuration as configuration 8.
/fs9 Save the current font configuration as configuration 9.
/f0 Reset the font to the spreadsheet.
/f1 Recall font configuration 1.
/f2 Recall font configuration 2.
/f3 Recall font configuration 3.
/f4 Recall font configuration 4.
/f5 Recall font configuration 5.
/f6 Recall font configuration 6.
/f7 Recall font configuration 7.
/f8 Recall font configuration 8.
/f9 Recall font configuration 9.

Header Examples:



 
/fb1 /l Title Of EasyList\n Prints in EasyList font name and font 

size, bold and left justified.
/fb1 /fi1 /c Title Of EasyList\n Prints in EasyList font name and font 

size, bold, italic, and center justified
/fn"Arial" /fz"14" /fb1 /c Title Of 
EasyList\n

Prints in Arial font, in font size 14, bold 
and center justified.

Footer Example:
/fb1 /l Page /p Prints in EasyList font name and font 

size, bold and left justified, inserts 
current page number while printing.

Note 1: The default font is the same as the EasyList font.
Note 2: You can override the default font by explicitly specifying the name, size, and 

other font attributes explicitly.
Note 3: You can use any font name that you can choose for EasyList. To see all the 

available fonts on your system, select the EasyList Font menu item from the 
EasyLists menu.

Note 4: You can use any font size that you can choose for EasyList for a given font. To 
see all the available font sizes for the given font name n your system, select the 
EasyList Font menu item from the EasyLists menu.



EasyList Print Dialog: Smart Print

Selecting Smart Print option prints the EasyList to best possible fit on a page. The following 
rules are used to determine the best fit:

1. If the number of columns are wider than a portrait page, the EasyList will print in 
landscape mode.

2. If the information still will not fit, but will fit in landscape mode if the EasyList is 
reduced up to 60% its original size, the EasyList will be scaled to fit within the 
page.

3. If the information is still too wide, the last attempt is to reduce the column widths 
to accommodate the widest string within each column.

4. If all attempts at trying to make the EasyList print within one page have failed, 
printing will resume normally in the current printer orientation with no reductions.



Overview Of EasyEditor

EasyEditor is the window where you can view and edit all the attributes of one object at a 
time. EasyEditor complements the EasyList in the sense that EasyList is the place where you
see the desired attributes of all (filtered using the filter criteria) the objects of a given type 
at one time, whereas in EasyEditor you see all the attributes of one object at one time. Both 
have their usefulness. You can choose to view and edit in any of the EasyLists or the 
EasyEditor. depending on your need and convenience.
You use EasyEditor for the following activities:

1. Create an object. See Creating An Object on how to create objects of any type 
in EasyEditor.

2. Delete an object. See Deleting An Object on how to delete objects of any type 
using EasyEditor.

3. Modify attributes of the object. See Editing An Object on how to modify object 
in EasyEditor.

4. Select an object to edit. See Selecting An Object on how to select an object to 
view in the EasyEditor.

To view and edit an object in the EasyEditor, you first select the object you want to view 
and/or edit. Once you select the object, it will be displayed in the editor. You can then view 
and modify the individual attributes as you desire.
As soon as you modify a value of the attribute, the modified value is immediately visible 
everywhere the attribute is displayed including all the open EasyLists.
The EasyEditor changes its form depending on the type of object. The different types of 
objects that you can directly create, delete and modify are Person, Business and Group.
The editor window layout is explained in EasyEditor Layout.

See Also
EasyEditor Layout 
Overview of EasyList 
Overview of EasyLook 

Overview of Objects 
Creating An Object 
Editing An Object 
Deleting An Object 
Viewing An Object 
Selecting An Object 



EasyEditor Layout

The EasyEditor window is divided into three distinct areas. 
1. Title Area. This is the title of the window itself.
2. Object Display Area: This is the area that displays all the attributes of the 

chosen type of object.
3. Button Area: This is the bottom area of the editor where all the buttons are 

located.

Title Area
The title of the editor displays information of the current status of the editor
The title is continuously updated to reflect the current status of the editor. The title has the 
following format:

EasyEditor: <Edit Status> <Object Type>
The edit status    is either "Editing" or empty.
The Object Type is the type of the object that is displayed in the Object Display Area. For 
example, Person is an object type. Business is another object type.

Object Display Area
This is the area where you view and edit all the attributes of a given type of object. This area
changes its form depending on the currently chosen type of object. If an object is currently 
selected , then the type of object is the type of the selected object, otherwise the type of the
object is the type of object that you choose by pressing the Type... button (see below).
Each attribute of the object is displayed in one line as follows:

Attribute Name    Attribute Value Box    [<Attribute Buttons>]
Attribute Name is the name of the attribute that is displayed in that row
Attribute Value Box is the value of the attribute if an object is being displayed, or empty if
no attribute is being displayed. The value box is white if you can edit the value of the 
attribute. It is gray if you can only read the value, but not edit it. 
For attributes, that can have multiple values, the value box is a drop down list box capable 
of displaying multiple values of the attribute. If the attribute is a date, then the value box 
displays date spin buttons. Otherwise, the value box is a simple edit box where you can type
the value or modify the old value.
Attribute Buttons are buttons that further help in editing the attribute values. Different 
buttons appear and disappear depending on the attribute 
The following attribute buttons may appear at various times:
New Attribute Button: This button appears only for attributes that specify postal address, 
electronic mail address or phone numbers. Pressing this button will pop up a window to 
define a new value of the attribute.
Delete Attribute Button: This button appears only for attributes that specify postal address, 



electronic mail address or phone numbers. Pressing this button will delete the existing value 
of the attribute. If the attribute can have multiple values, than a selection box will be 
displayed first for you to choose which particular value you want to delete.
Edit Attribute Button: This button appears only for attributes that specify postal address, 
electronic mail address or phone numbers. Pressing this button will pop-up a window to edit 
the existing value of the attribute. If the attribute can have multiple values, than a selection 
box will be displayed first for you to choose which particular value you want to edit.
Add Attribute Button: This button appears only for multi-valued attributes. Pressing this 
button will pop-up a selection box for you to select one of the possible values to add to the 
attribute.
Remove Attribute Button: This button appears only for multi-valued attributes. Pressing this 
button will pop-up a selection box of all the current values of the attribute for you to choose 
to remove from the set of attribute values.
Select Attribute Button: This button appears only for attributes whose value can only be the 
name of another object, or if the attributes can only have one of the pre-defined values 
defined by EasyManager.

Buttons

First Button (<<)
Press this button to select the first object of the type for which the form is displayed. For 
example if the Editor is currently displaying the form for Person objects, then the first 
object (determined by sorting all Person objects by name attribute) is selected and 
displayed.

Previous Button (<)
Press this button to select the previous object of the type (for which the form is 
displayed) with respect to the object being edited currently. The previous object is 
determined by sorting all the objects of the type that is being edited by name attribute, 
and then selecting the object that is before the object that is currently being edited. If no
object is being edited currently, then the first object is selected and displayed.

Next Button (>)



Press this button to select the next object of the type (for which the form is displayed) 
with respect to the object being edited currently. The next object is determined by 
sorting all the objects of the type that is being edited by name attribute, and then 
selecting the object that is after the object that is currently being edited. If no object is 
being edited currently, then the last object is selected and displayed.

Last Button (>>)
Press this button to select the last object of the type for which the form is displayed. For 
example if the Editor is currently displaying the form for Person objects, then the last 
object (determined by sorting all Person objects by name attribute) is selected and 
displayed.

Find Box
This is a box where the name of the object being edited currently is displayed. You can 
select an object directly by simply entering the name and pressing return. You may enter
only partial name. If more than one object match the name, then you will be given a 
selection box to make further selection.

Select Button (Sel...)
Press this button to select a object of the type that is displayed in the Object Display 
Area that you want to view or edit.

New Button (New)
Press this button to create a new object of the type that is currently displayed. Pressing 
this button deselects any object that was selected before. This clears and grays out all 
the attribute value boxes except the Name attribute in the Object Display Area. This 
button does not actually create an object. The object is created as soon as you specify 
the name and press return or tab.

Delete Button (Del)
Press this button to delete the object that is currently displayed in the editor. The object 
that is currently displayed, is always the currently selected object.

Close Button (Close)
Press this button to close the EasyEditor. You can also double click on the window's 
system menu in the upper left corner of the window.

Type Button (Type...)
Press this button to change the type of object that you want to view, create, edit or 
delete from the editor. This will display a selection box of all the possible types. Choose a
type by double clicking on one of the selections or clicking once and than clicking the OK 
button.

See Also
Overview of EasyEditor 
Overview of Objects 



Overview of EasyLook

EasyLook allows you to view certain information on all Objects quickly and easily without 
having to search within one or more EasyList and/or EasyEditor. You can also search 
incrementally by the objects key by activating the incremental search.
You can invoke the EasyLook feature by one of the following ways:

1. Select EasyLook menu item from the Edit menu.
2. Use keyboard shortcut Ctrl+L.
3. Click on the EasyLook icon on the toolbar 

To lookup the desired information, you need to do the following:
1. Select what kind of information you want to lookup. You do this by pressing the 

Setup... button.
2. Enter the search string (partial or full string) that is part of the name of the 

object. You select the search criteria to use for searching within the EasyLook 
Setup Dialog.

3. Press Enter or click on the Look button.
The result is displayed in the result area.
Once the result of your search is displayed, EasyLook does not automatically update the 
result information if you later create, modify or delete objects which can affect the result. 
This is done purposely for performance reasons. You can update the result by redoing the 
search by simply pressing the Look button.

You can also right click in the row to display a context dependent menu that will allow you to
dial and send email to the object that is being displayed.
See Also

EasyLook Layout
EasyLook Setup Dialog
Overview of EasyEditor
Overview of EasyList



EasyLook Layout

EasyLook window has the following components:

Result
This is a read-only scrolling area where the result of the lookup is displayed. You can 
scroll up and down the result, select and copy the text to clipboard. You can also select 
objects, and popup right button context dependent menu from within the result area.

String To Search
Enter the search string that you want to lookup. Search string is used in conjunction with 
the search criteria that you select from the EasyLook Setup Dialog, to look up the desired
information only of the objects whose name attribute matches the search string.

Incremental
This is a check box, which when checked enables the incremental searching of objects by
the key value. Checking this check box automatically searches for all the objects starting 
with the given string.

Look
Press this button to look up desired information of objects that satisfy the search string 
using the selected search string criteria.

Setup...
Press this button to display the EasyLook Setup Dialog. Use this dialog box to specify the 
information you want to lookup, and the search criteria to use for filtering objects whose 
information should be displayed.

Close
Press this button to close the EasyLook window.

See Also
Overview of EasyLook
EasyLook Setup Dialog



EasyLook Setup Dialog

EasyLook Setup Dialog is used to customize information you want to look up of a given 
object, and the criteria to use to search for objects for which you want to lookup the desired 
information.

What To Look 
You may look up one or more of the following information on objects:
Postal Address: Select this to lookup Person's home and work address, and Business's 
postal address.
Telephone Number: Select this to lookup Person's home and work telephone numbers, and
Business's telephone number.
Fax Number: Select this to lookup Person's home and work fax number, and Business's fax 
number.
Email Address: Select this to lookup Person's electronic mail address, and Business's 
electronic mail address.
Birth Date: Select this to lookup Person's birth date.
Marriage Date: Select this to lookup Person's marriage date.
Relationships: Select this to lookup Person's father, mother, spouse and children.
Account Details: Select this to lookup Account number, type, access code, and expiration 
date.

Search Criteria To Search For Objects
You specify how to match the search string with the name of the object (Name attribute for 
Person Object, Business Name for Business Object, Account Name for Account Object, 
and Group Name for Group Object). Information is looked up only for the objects that match
the search string using the criteria you specify 
You can specify one of the following match criteria:
Contains: This criteria matches all objects whose name contains the search string.
Begins With: This criteria matches all objects whose name starts with the search string.
Exact: This criteria matches all objects whose name is the same as the search string.
In addition to the above search criteria, you can also choose to ignore case or not ignore 
case while matching the search string. To ignore case, select the Ignore Case option.

See Also
Overview of EasyLook
EasyLook Layout

Person Object



Business Object
Account Object
Group Object



Overview Of EasyFilter

EasyFilter feature allows you to filter objects such that you view only those objects that meet
the filter criteria you define. To filter objects in any EasyList or EasyLabel, you need to do 
two things:

1. Define Filter Criteria
2. Associate Filter Criteria with one or more EasyList(s) and EasyLabel(s).

A filter criteria is defined for a given type of Object. Once defined it can be associated with 
any number of EasyLists and EasyLabels that are also defined for the same type of Object. 
Thus you define a filter criteria once, and then use it over and over again.
You can define any filter criteria you like. You can use AND/OR expression and use 
parenthesis if you like. A simply expression is simply Attribute operator Value    Two 
simple expressions can be ANDed or Ored together two form a compound expression. The 
compound expression can also use parenthesis to decide the order in which AND/OR 
expressions will be evaluated. See Filter Expression for more details.

See Also
EasyFilter Editor
EasyFilter Expression



EasyFilter Expressions

EasyFilter expression consist of a combination of one or more simple expressions 
ANDed/ORed together. Expressions can also be enclosed within parenthesis. A simple 
expression consists of Attribute operator Value.
Attribute
An attribute of an object is specified by enclosing the internal name of the desired attribute 
within $( ). If an attribute of an object points to another object, then a list of attributes can 
be specified separated by spaces and enclosed within the $( ). 
Examples of attributes of Person object are:
$(name) : this refers to the name of the object.
$(father) : this refers to the father of the object.
$(birthDate) : this refers to the birth date of the object.
$(father sex) : this refers to the sex of the father.
$(spouse birthDate) : this refers to the spouses birth date.
Note that an attribute specification can be made to traverse many object starting from the 
given object. For instance in the example above, the value of $(spouse birthDate) is the birth
date of the spouse. Thus, the EasyManager starts with a given object, goes to the spouse 
object of the given object and then gets the value of birthDate attribute of the spouse 
object.
One can imagine an attribute specification such as:$(father father birthDate), which would 
refer to grand fathers birthDate.
Operator
An operator is used to decide what kind of comparison must be done between the value of 
the attribute of the object and the value specified in the filter expression. The following 
operators are recognized. However, not all operators can be used to compare different date 
types of attributes.

Equal to (=)
Not equal to (!=)
Greater than or equal to (>=)
Less than or equal to (<=)
Greater than (>)
Less than (<)
Contains (CN)
Does not contain (NCN)
Begins With (BW)
Does not begin with (NBW)
Ends with (EW)
Does not end with (NEW)

Value
This is the value that is used to compare against the attribute value of the object. The value 
is enclosed within quotes for string attributes, and enumerated attributes. The value can 
also have a special value of EMPTY, which implies that the attribute value must be zero.



Examples:
To view only the Person objects whose spouses were born before 01/01/1925, the filter string
would be $(spouse birthDate) < 01/01/1925.
To view only the Person objects who are head of household, the filter string would be $
(livingWith) = EMPTY.
To view only the Person objects who are Female or single, the filter string would be $
(spouse) = EMPTY Or $(sex) != Male.

See Also
Overview Of EasyFilter
EasyFilter Editor



Overview Of EasySort

EasySort feature allows you to sort objects so you view objects in the order you desire. You 
can define as many sort keys as you want. Moreover, the sort keys need not be the same as 
the attributes you are viewing in EasyLists or EasyLabels. To sort objects in any EasyList or 
EasyLabel, you need to do two things:

1. Define Sort Criteria
2. Associate Sort Criteria with one or more EasyList(s) and EasyLabel(s).

You define the sort criteria, by invoking the EasySort Editor (Select Define EasySort... 
menu item from Edit menu. You associate EasySort criteria with one or more EasyLists by 
invoking the EasyList Editor. You associate EasySort criteria with one or more EasyLabels by 
invoking the EasyLabel Editor.

See Also
EasySort Editor
EasyFilter Expression



Selection Dialog

Selection Dialog is a common dialog that displays a list of choices that you choose from. The
list of choices displayed in the selection dialog box depends on the context. Depending on 
the context, it will display one of the following:

1. Names of the objects i.e. Name attribute of Person object, Business Name 
attribute of the Business object, and/or Group Name of the Group object.

2. Type of object. Currently, there are three type of objects:. Person, Business, 
and Group.

3. Discrete choices for attributes that accept only a pre-defined values, like 
choices Male and Female for Sex attribute of Person object.

To make a selection
1. Double click on the desired selection, or
2. Click once on the desired selection and then press OK button, or
3. Click once on the desired selection and press Return/Enter button.

To scroll through the list of choices:
1. Scroll using scroll keys (Page Up, Page Down, Arrow Up, Arrow Down, Home and  

End), or
2. Press the alphabet key to jump to the next selection that starts with the desired 

alphabet.

To cancel the selection:
1. Press Cancel button, or
2. Press Esc button.

See Also
Overview of Objects
Person Object
Business Object
Account Object
ToDo Object 
Reminder Object 
Group Object

Overview of EasyList
Overview of EasyEditor



Keyboard Shortcuts

There are many keyboard shortcuts that are defined in EasyManager to improve your 
productivity. The following table lists all of them.

Commands
Key Action

Ctrl+N Open A New Document
Ctrl+O Open An Existing Document
Ctrl+S Save An Open Document

Ctrl+D Delete Selected Object
Ctrl+J Jump To Object
Ctrl+E Open EasyEditor
Ctrl+L Open EasyLook
Ctrl+P Print Active EasyList
Ctrl+I Open EasyImport

F1 Help
Shift F1 Context Sensitive Help

Ctrl+X Cut current selection and copy to Clipboard
Ctrl+C Copy current selection to Clipboard
Ctrl+V Paste from Clipboard

EasyList and EasyEditor

Key Action

Up Arrow Activate the cell above the current active cell
Down Arrow Activate the cell below the current active cell
Right Arrow Activate the cell right of the current active cell
Left Arrow Activate the cell left of the current active cell
Page Up Move the active cell one page up
Page Down Move the active cell one page down
Ctrl + Page Up Move the active cell one page to the left
Ctrl + Page Down Move the active cell one page to the right
Home Move the active cell to the first cell in the row
End Move the active cell to the last column that has data, staying 

within the current row
Ctrl + Home Move the active cell to row one, column one
Ctrl + End Move the active cell to the last column that has data, staying 

within the current row



Tab Move to the next cell that can be edited    from the current 
active cell, the order is right, then down

Shift-Tab Move to the previous cell that can be edited from the active cell,
the order is left, then up

Ctrl + X Cut the current selection or cell's data to the clipboard
Ctrl + C Copy the current selection or cell's data to the clipboard
Ctrl + V Paste the clipboard into the current cell location
Enter If editing a cell, signal the end of edit, and move to the next cell

that can be edited, the order is right, then down
Esc If editing a cell, cancel the editing and restore the old cell value
F2 If editing a cell, clear the cell value
F3 If editing a date cell value, the current date will be placed in the

cell
F4 If editing a date cell value, a pop-up calendar will be displayed 

for choosing a date



Feedback

We wish to thank you for using EasyManager For Windows. We at TekFocus Corporation are 
committed to make EasyManager For Windows the product of your choice to manage your 
personal information and export the information to other applications as and when you need
it.
Please let us know if you have any problems with the current version of EasyManager, or 
comments or suggestions on how to further improve the product. You can contact us in any 
of the following ways:

1. Send us an electronic mail, our Internet Address is vivek@tekfocus.com. From 
CompuServe the address is internet:vivek@tekfocus.com. This is the most 
preferred way.

2. Fax us. Our fax number is 408.452.0440.
2. Call us by phone. Our phone number is 408.452.0110. Please leave a message

at the voice mail.
3. Send us a US Mail letter. Our postal address is :

TekFocus Corporation
1578 Theo Drive
San Jose, CA 95131

Please include your name, daytime phone number, electronic mail address if any, product 
version, and the problem, suggestions, or comments that you want to share with us.
Thank you for taking the time to talk to us.



Registering EasyManager

To register EasyManager For Windows, simply fill out the registration form. Registration form 
is provided as a WRITE document which you can view by clicking on the Registration 
Form icon in the EasyManager For Windows Program Group or by simply opening the 
register.wri using the WRITE program, or by simply printing the register.txt file directly. 
Both these files appear under the installation directory for EasyManager For Windows.
Alternatively, you can also register by simply following the instructions below:
To register your copy of EasyManager For Windows, send a check for $17.00 payable to 
TekFocus Corporation at the following address:

TekFocus Corporation
1578 Theo Drive
San Jose, CA 95131.

Please include the following information along with your payment:
1. Name
2. Company Name
3. Postal Address
4. Day Time Phone
5. Day Time Fax
6. Electronic Mail Address (important for email notification for upgrades)

When you register you get a number of benefits.
· You will get new capabilities as they become available.
· You will also receive free updates of the software as they are released for at 

least one year.
· Registration is required if you continue to use EasyManager after 30 days from 

the date of installation.



About TekFocus Corporation

TekFocus Corporation is the developer of EasyManager For Windows. TekFocus Corporation 
specializes in consulting and contracting in all aspects of software development including:

· Client/Server Applications
· Object Oriented Databases (ObjectStore)
· Object Technology Re-engineering
· Software Architecture
· Class Libraries
· Localization
· VLSI CAD (Physical)
· UNIX and MS-Windows Platforms
· Offshore & Offsite Development
· C++, C, Visual Basic, PostScript

Please contact TekFocus Corporation for your consulting needs as follows:
TekFocus Corporation
1578 Theo Drive
San Jose, CA 95131.

Tel: 408.452.0110
Email: vivek@tekfocus.com



EasyManager Commands Index
Commands

File menu
Edit menu
View menu
EasyList menu
EasyLabel menu
Window menu
Help menu



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print 
EasyList

Prints currently active EasyList.

Print Setup Selects a printer and printer connection.
EasyExport Displays the EasyExport Dialog to export data to other applications.
EasyImport Displays the EasyImport Dialog to import data from other applications.
Exit Exits EasyManager.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data and moves it to the clipboard.
Copy Copies data to the clipboard.
Paste Pastes data from the clipboard.
Delete Object Deletes the selected object from database.
Jump To Object Jumps to the object that is being referred to in the active 

cell in the EasyEditor or EasyList.
EasyEditor Invokes EasyEditor to create, modify and delete objects
EasyLook Invokes EasyLook to quickly lookup specific information
EasyEditor 
Font

Invokes Font Dialog to customize EasyEditor Font

Define 
EasyFilter

Invokes Define EasyFilter dialog to create new filters, 
edit/delete existing filters

Define 
EasySort

Invokes Define EasySort dialog to create new sort criteria, 
edit/delete existing sort criteria.

Edit 
Preferences

Invokes Preference Dialog to edit your preferences to 
customize certain aspects of application



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.



EasyList menu commands

The EasyList menu offers the following commands:

Lists Displays the names of the currently defined EasyLists that 
can be opened to view, create, modify and delete objects.

Define 
EasyList

Displays the dialog box to define a new EasyList and to 
modify or delete one of the existing EasyList.

EasyList Font Displays the font dialog box to chose a font in which all 
EasyLists will be displayed.



EasyLabel menu commands

The EasyLabel menu offers the following commands:

Labels,... Displays the names of the currently defined 
EasyLabels that can be opened to view, create, modify
and print labels.

Define EasyLabel Displays the dialog box to define new EasyLabels and 
to modify or delete existing EasyLabels.

EasyLabel Font Displays the font dialog box to chose a font in which 
all EasyLabels will be displayed.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new EasyList window that displays the same list 
as the currently active EasyList.

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get 
help.

Using Help Provides general instructions on using help.
Getting Started Offers instructions to quickly learn to start using 

EasyManager.
Registering 
EasyManager

Displays help on how to register your copy of 
EasyManager.

About EasyManager Displays the version and registration information of 
this application.

About Vivek 
Technologies

Displays contact information about the company.



New command (File menu)

Use this command to create a new document in EasyManager.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document .    You can have only one open document. 
If a document is already open, that document will first be closed and then the requested 
document opened. You specify the file to open in the File Open dialog box

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
You can only open files with exc extension

Drives
Select the drive in which EasyManager stores the file that you want to open. 

Directories
Select the directory in which EasyManager stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    EasyManager 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, EasyManager displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, EasyManager displays the Save As dialog box so you 
can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    EasyManager displays the Save 
As dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    EasyManager adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your EasyManager session.    You can also use the Close command 
on the application Control menu.    EasyManager prompts you to save documents with 
unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the command 
changes, depending on what the last action was. The Undo command changes to Can't Undo
on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

This feature not yet available.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard. This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if 
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



EasyEditor Font (Edit menu)

Use this command to select the font to use when displaying the data in the EasyEditor. This 
command displays the Choose font dialog box.

Shortcuts
None



Define EasyFilter (Edit menu)

Use this command to define a new EasyFilter, modify the definition of the existing EasyFilter 
or delete the definition of an existing EasyFilter. This command displays the Define EasyFilter
dialog box.

Shortcuts
None



Define EasySort (Edit menu)

Use this command to define a new EasySort, modify the definition of the existing EasySort or
delete the definition of an existing EasySort. This command displays the Define EasySort 
dialog box.

Shortcuts
None



Edit Preferences (Edit menu)

Use this command to specify your preferences to customize certain aspect of application 
behavior. This command displays the Edit Preferences dialog box.

Shortcuts
None



Edit Preferences Dialog

The following preferences can be set to customize the application behavior.

Open Last Opened File On Startup
Check this box if you want EasyManager to automatically open the data file that you had 
opened last time when you ran EasyManager For Windows. If you generally work with 
just one file, than it is convenient to check this option.

Share Home Telephone Numbers When Living Together
Check this box if you want EasyManager to automatically share the home telephone 
numbers amongst persons living together.

If this option is checked, when you change the home telephone numbers of a person, the
change is reflected for all the persons living together. If the option is unchecked, for all 
persons that are living with another person, will not share the telephone numbers.

Share Home Fax Numbers When Living Together
Check this box if you want EasyManager to automatically share the home fax numbers 
amongst persons living together.

If this option is checked, when you change the home fax numbers of a person, the 
change is reflected for all the persons living together. If the option is unchecked, for all 
persons that are living with another person, will not share the home fax numbers.

Share Working Telephone Numbers When Working Together [Not Available]
Check this box if you want EasyManager to automatically share the work telephone 
numbers amongst persons working together. In general if a person is working with 
another person, then company name and the work address is shared between the two 
persons, but the work telephone numbers are not.

If this option is checked, when you change the work telephone numbers of a person, the 
change is reflected for all the persons working together.

Share Work Fax Numbers When Working Together [Not Available]
Check this box if you want EasyManager to automatically share the work fax numbers 
amongst persons working together. In general if a person is working with another person,
then company name and the work address is shared between the two persons, but the 
work fax numbers are not.

If this option is checked, when you change the work fax numbers of a person, the change
is reflected for all the persons working together.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in EasyManager, such as File Open. A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to many tools used in EasyManager,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document. EasyManager displays the Open dialog box, in which you
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, EasyManager displays the Save As dialog box.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Invoke EasyLook to quickly lookup information on objects

Invoke EasyEditor to create, modify and delete objects.

Export data to ASCII files and other applications.

Import data from ASCII files.

Print the active EasyList.

About EasyManager.

Obtain context sensitive help 



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the EasyManager window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Define EasyList (EasyList menu)

Use this command to define a new EasyList, or modify the definition of the existing EasyList 
or to delete the definition of an existing EasyList. This command displays the Define EasyList
dialog box.

Shortcuts
None



Define Dialog (for EasyList, EasyLabel, EasyFilter, EasySort)

Define dialog presents the following options and actions:

Currently Defined Objects
This presents a list of all the currently defined EasyLists/EasyLabels/EasyFilters/EasySorts
as the case may be. To edit an existing definition, either double click on the desired 
definition to edit or select the definition and press the Edit button.

New...
Press this button to define a new EasyList/EasyLabel/EasyFilter/EasySort as the case may
be. This will display the appropriate editor to define a new definition.

Edit...
Press this button to edit an existing definition. This action is unavailable if no definition is
selected in the Currently Defined Objects box. This will display the appropriate editor.

Delete
Press this button to delete an existing definition This action is unavailable if no definition 
is selected in the Currently Defined Objects box.

Close
Press this button to close the dialog box.

Shortcuts
None



EasyList Font (EasyList menu)

Use this command to select the font to use when displaying the data in the EasyLists. All 
EasyLists are displayed in the chosen font. This command displays the Choose font dialog 
box.

Shortcuts
None



Define EasyLabel (EasyLabel menu)

Use this command to define a new EasyLabel, modify the definition of the existing EasyLabel
or delete the definition of an existing EasyLabel. This command displays the Define 
EasyLabel dialog box.

Shortcuts
None



EasyLabel Font (EasyLabel menu)

Use this command to select the font to use when displaying the data in the EasyLabels. All 
EasyLabels are displayed in the chosen font. This command displays the Choose font dialog 
box.

Shortcuts
None



New command (Window menu)

Use this command to open a new EasyList window with the same contents as the active 
EasyList window.    You can open multiple EasyList windows to display different parts of an 
EasyList at the same time.    If you change the contents in one window, all other windows 
reflect those changes.    When you open a new EasyList window, it becomes the active 
window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

EasyManager displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the name of the active window.    Choose a 
window name from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using EasyManager and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About EasyManager command (Help menu)

Use this command to display the copyright notice, version number, and registration 
information of your copy of EasyManager.



About Vivek Technologies command (Help menu)

Use this command to display information about the company, and means to contact the 
company for suggestions and problems regarding the application, and for offshore and 
offsite consulting.



Context Help command 

Use the Context Help command to obtain help on some portion of EasyManager.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the EasyManager window, such as another Toolbar
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



EasyManager Registration

This dialog is used to view and update registration information.

Name
View/modify the name of the user under whose name the software is registered or will be
registered. A name must be specified.

Company Name
View/modify the company name of the user under whose name the software is registered
or will be registered. Specifying a company name is optional.

Serial Number
View/modify the serial number of the software. The serial number can be specified to be 
zero (0), if you are installing a shareware version or you can specify a registered serial 
number. If you have a shareware version of the software, you can use it for 30 days from 
the date of installation, after which you must register to continue using it. See 
Registering EasyManager for details on how to register your copy of EasyManager.

Update
Press this button to update the registration information.

Cancel
Press this button to cancel any changes you made to the registration information and to 
close the dialog.



Title Bar

The title bar is located along the top of a window.    It contains the name of the window 
indicating the purpose of that window.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the window. The scroll boxes inside the scroll 
bars indicate the relative position of all the data that you can see in the window.    You can 
use the mouse or the scroll keys to scroll to see the data.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the EasyManager window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    EasyManager determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    EasyManager 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the active window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

Choose Font dialog box is used to specify a font. The dialog box has the following options:

Font:
Presents a list of all the available fonts from which to choose a font from.

Font Style:
Presents a list of the available styles for the currently chosen font.

Size:
Presents a list of possible font sizes for the currently chosen font.

Effects:
Presents the option to underline or to strikeout the currently chosen font.

Color:
Presents a drop-down list of colors to select from for the currently chosen font.

Sample:
This is the area where a sample of how the font would look like if the current font setting 
is selected.



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context id. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context id. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context id. used by this help topic for the 
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    



HINT_DATE_VARIABLES

No Help Available



HINT_DEFINE_FILTER

No Help Available



HINT_SHARE_MARRIAGE_DATE

No Help Available



HINT_GROUP_OBJECTS1

No Help Available



HINT_GROUP_OBJECTS2

No Help Available



HINT_GROUP_OBJECTS3

No Help Available



HINT_LIST_MODIFY

No Help Available



HINT_LABEL_MODIFY

No Help Available



HINT_FIND_OBJECT2

No Help Available



HINT_FIND_OBJECT1

No Help Available



HINT_DATE_F4

No Help Available



HINT_DATE_F3

No Help Available



EDIT_HINT_PREFIX

No Help Available



HINT_LABEL_PRINT_START

No Help Available



HINT_SHARE_WORK_ADDRESS1

No Help Available



HINT_SHARE_HOME_ADDRESS2

No Help Available



HINT_SHARE_HOME_ADDRESS1

No Help Available



HINT_SHARE_WORK_ADDRESS2

No Help Available



HINT_EXPORT_TEXT_FILE

No Help Available



HINT_IMPORT_TEXT_FILE

No Help Available



HINT_LOOKUP_PHONE

No Help Available



HINT_LABEL_NEW

No Help Available



HINT_ADDRESS

No Help Available



HINT_LOOKUP_ADDRESS

No Help Available



HINT_REMINDER

No Help Available



HINT_FAMILY_RELATION

No Help Available



HINT_EDITOR_VIEW_OBJECT

No Help Available



HINT_CHILD

No Help Available



HINT_REMINDER_DATES_BEFORE

No Help Available



HINT_HELP

No Help Available



HINT_REMINDER_DATES

No Help Available



HINT_CUSTOM_LABEL

No Help Available



HINT_CUSTOM_LIST

No Help Available



HINT_PRINTING_ADDRESS_BOOK

No Help Available



HINT_USE_EDITOR

No Help Available



HINT_PREFERENCES

No Help Available



HINT_LABEL_PRINT_ONE

No Help Available



HINT_LIST_NEW

No Help Available



HINT_LIST_DELETE

No Help Available



HINT_LABEL_DELETE

No Help Available



HINT_RIGHT_MOUSE

No Help Available



HINT_DATE_CALENDAR

No Help Available



HINT_EXPORT_COMPUSERVE

No Help Available



HINT_DEFINE_SORT

No Help Available



HINT_REMINDER_TODO

No Help Available



HINT_LOOKUP_EMAIL

No Help Available



UNKNOWN_PROPERTY

No Help Available



INVALID_CLASS_NAME

No Help Available



NULL_ATTRIBUTE_NAME

No Help Available



ATTRIBUTE_TYPE_MISMATCH

No Help Available



INVALID_ATTRIBUTE_INDEX

No Help Available



NULL_ATTRIBUTE_ARRAY

No Help Available



CIM_UNKNOWN_VERSION

No Help Available



NO_EXPORTDATA

No Help Available



CIM_READ_ERROR

No Help Available



EXPORT_SUCCESS

No Help Available



CIM_WRITE_ERROR

No Help Available



OPEN_FAILED

No Help Available



CIM_EXTRACTION_FAILED

No Help Available



RENAME_FAILED

No Help Available



CYCLE

No Help Available



WILL_FORM_CYCLE

No Help Available



ERROR

No Help Available



EACCES

No Help Available



EIO

No Help Available



ENOTDIR

No Help Available



INVALID_DATA_OP

No Help Available



INVALID_DATA_ATTR

No Help Available



INVALID_DATA_ANDOR

No Help Available



UNREACHABLE_ATTRLIST

No Help Available



INVALID_CLASSNAME

No Help Available



EMPTY_FILTER_NAME

No Help Available



INVALID_DATA_VALUE

No Help Available



INVALID_FILTERSTRING

No Help Available



EMPTY_FILTERSTRING

No Help Available



VALIDATION_FAILED

No Help Available



INVALID_DATA_OPENPAREN

No Help Available



EMPTY_TYPE

No Help Available



INVALID_DATA_CLOSEPAREN

No Help Available



INVALID_COL_DEF

Column definition is not valid. The colum definition will be ignored



PRIMARY_COL_IS_FIXED

No Help Available



NO_OBJECT_CLASS

No Help Available



UNKNOWN_CLASS_NAME

The class name (object type) specified is not known or is empty, edit the list and specify a 
valid class (object type).



FILTER_NOT_FOUND

No Help Available



SORT_SCHEMA_NOT_FOUND

No Help Available



DATABASE_MISMATCH

No Help Available



INVALID_FILTER_OBJECT

No Help Available



CREATE_FAILED

Failed to create the desired object within the database. Most probably you have insufficient 
memory. Close some other applications and try again.



INVALID_SORT_SCHEMA_OBJECT

No Help Available



NO_COL_CHOICE

You have not selected an attribute to display in the specified column. You must either select 
an attribute, or delete the column.



EMPTY_LIST_NAME

No Help Available



CANNOT_JUMP_WHEN_EDITING

No Help Available



NOTHING_TO_REMOVE

No Help Available



HINT_APPLY_SORT

No Help Available



HINT_APPLY_FILTER

No Help Available



HINT_MULTIVALUED_ADD_REMOVE

No Help Available



INVALID_COLUMN_ATTRIBUTE_LIST

No Help Available



HINT_BLANK_COL

No Help Available



CELL_IS_EMPTY

No Help Available



HINT_EMAIL

No Help Available



OBJECT_BY_KEY_DOES_NOT_EXIST_CREATE_OK

No Help Available



HINT_DIAL

No Help Available



HINT_LOOKUP_PHONE

No Help Available



INVALID_CLASS_NAME

No Help Available



TOGGLE_TEXT_WRAP

No Help Available



INVALID_ROW

No Help Available



HINT_SELECT_OBJECT

No Help Available



HINT_EDIT_OBJECT

No Help Available



NO_OBJECT_FOR_ROW

No Help Available



CREATE_DUPLICATE_KEY_OBJECT

No Help Available



HINT_CREATE_OBJECT

No Help Available



HINT_DELETE_OBJECT

No Help Available



EDIT_PRIMARY_COLUMN_FIRST

No Help Available



INVALID_VALUE

No Help Available



HINT_ENUM

No Help Available



HINT_LOOKUP_EMAIL

No Help Available



ATTRIBUTE_CANNOT_BE_NULL

No Help Available



INVALID_COLUMN

No Help Available



CANNOT_JUMP_OBJECT_NOT_IN_LIST

No Help Available



KEY_OBJECT_EXISTS_RENAME

No Help Available



GET_ALL_OBJECTS_FAILED

No Help Available



NOTHING_TO_DELETE

No Help Available



HINT_MULTIVALUED_NEW_DELETE

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



OBJECT_CREATE_FAILED

No Help Available



INIT_SORT_FAILED

No Help Available



NO_SELECTED_OBJECT

No Help Available



NO_DATA

No Help Available



INVALID_CLASS_NAME

No Help Available



INIT_FILTER_FAILED

No Help Available



UNKNOWN_CLASS

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



NOT_FIXED_WIDTH_HEIGHT

No Help Available



SYNTAX_ERROR

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



OBJECT_CREATE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



CREATE_DUPLICATE_VALUE_OBJECT

No Help Available



NULL_ENUMERATOR_ARRAY

No Help Available



NULL_ENUMERATOR_NAME

No Help Available



INVALID_ENUM_NAME

No Help Available



NULL_FILE_NAME

No Help Available



SEEK_FAILED

No Help Available



PARSE_ERROR

No Help Available



DUPLICATE_OBJECT_ID

No Help Available



READ_FAILED

No Help Available



INVALID_ATTRIBUTE_VALUE_IGNORED

No Help Available



INVALID_ATTRIBUTE_NAME_IGNORED

No Help Available



CLASS_PROPERTY_DEFINITION_FAILED

No Help Available



OPEN_FAILED

No Help Available



ATTRIBUTE_PROPERTY_DEFINITION_FAILED

No Help Available



ENUM_DEFINITION_NOT_IN_PROGRESS

No Help Available



OBJECT_DEFINITION_NOT_IN_PROGRESS

No Help Available



CLASS_DEFINITION_IN_PROGRESS

No Help Available



CLASS_DEFINITION_NOT_IN_PROGRESS

No Help Available



OBJECT_DEFINITION_IN_PROGRESS

No Help Available



ENUM_DEFINITION_IN_PROGRESS

No Help Available



INVALID_DATA_ATTR

No Help Available



UNREACHABLE_ATTRLIST

No Help Available



INVALID_ATTRINDEX

No Help Available



INVALID_OBJECT_CLASS_NAME

No Help Available



CNV_SORT_KEY_TO_STRING_FAILED

No Help Available



EMPTY_SORT_NAME

No Help Available



VALIDATION_FAILED

No Help Available



NOT_SORT_SCHEMA

No Help Available



EMPTY_TYPE

No Help Available



INVALID_SORTSTRING

No Help Available



EMPTY_SORTSTRING

No Help Available



NULL_INDIRECT_ATTRIBUTE

No Help Available



INDIRECT_ATTRIBUTE_NOT_POINTER

No Help Available



GET_INDIRECT_ATTRIBUTE_FAILED

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



SET_ATTRIBUTE_FAILED

No Help Available



INVALID_ATTRIBUTE_INDEX

No Help Available



INDIRECT_ATTRIBUTE_PATH_TERMINATED

No Help Available



OK_TO_DELETE

No Help Available



IS_FATHER_OF

No Help Available



WORKING_WITH_ONESELF

No Help Available



LIVING_WITH_ONESELF

No Help Available



LIVING_WITH_HEAD_OF_HOUSEHOLD

No Help Available



SEX_MISMATCH

No Help Available



ANCESTOR

No Help Available



SEX_UNDEFINED_IS_MALE

No Help Available



WORKING_WITH_SOMEONE_ELSE

No Help Available



LIVING_WITH_SOMEONE_ELSE

No Help Available



FIRST_NAME_EMPTY

No Help Available



IS_MOTHER_OF

No Help Available



INVALID_PARTS

No Help Available



HINT_MULTIVALUED_ADD_REMOVE

No Help Available



OBJECT_BY_KEY_DOES_NOT_EXIST_CREATE_OK

No Help Available



CANNOT_JUMP_WHEN_EDITING

No Help Available



HINT_EDIT

No Help Available



ENTER_KEY_ATTRIBUTE_VALUE_FIRST

No Help Available



KEY_ATTRIBUTE_CANNOT_BE_EMPTY

No Help Available



GET_ATTRIBUTE_FAILED

No Help Available



UPDATE_ATTRIBUTE_FAILED

No Help Available



CONVERSION_TO_ATTRTYPE_FAILED

No Help Available



HINT_MULTIVALUED_NEW_DELETE

No Help Available






